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The National Curriculum Framework, 2005, recommends that children’s life at school must be linked to 
their life outside the school. This principle makes a departure from the legacy of bookish learning 
which continues to shape our system and causes a gap between the school, home, community, and the 
workplace. 

 
The student workbook on “3D Production Pipeline” is a part of the qualification package developed 
for the implementation of National Vocational Education Qualification Framework (NVEQF).  The 
NVEQF, an initiative of the Ministry of Human Resource Development (MHRD), Government of India, set 
common principles and guidelines for a nationally recognized qualification system covering Schools, 
Vocational Education and Training Institutions, Technical Education Institutions, Colleges and 
Universities. It was subsumed in National Skills Qualifications Framework (NSQF) in 2013. It is envisaged 
that the NSQF will promote transparency of qualifications, cross-sectoral learning, and student-centred 
learning and facilitate learner’s mobility between different qualifications, thus encouraging lifelong 
learning. 

 
This student workbook, which forms a part of vocational qualification package for students who have 
passed Class VIII or equivalent examination, was created by a group of experts. The Media and 
Entertainment Sector Skill Council approved by the National Skill Development Corporation (NSDC) for 
the Media and Entertainment Industry developed the corresponding National Occupational Standards 
(NOS) and the Qualification Pack (QP). The National Occupational Standards are a set of competency 
standards and guidelines endorsed by the representatives of Media and Entertainment Industry for 
recognizing and assessing skills and knowledge needed to perform effectively in the workplace. 

 
The Pandit Sunderlal Sharma Central Institute of Vocational Education (PSSCIVE), a constituent of 
National Council of Educational Research and Training (NCERT) has developed modular curricula and 
teaching-learning materials for the vocational qualification package in Media and Entertainment sector 
for NSQF levels 1 to 4; level 1 is equivalent to Class IX. Based on NOS, generic and occupation related 
core competencies (knowledge, skills, and abilities) were identified for development of curricula and 
learning modules. 

 
This student workbook attempts to discourage rote learning and to bring about necessary flexibility in 
offering of courses, necessary for breaking the sharp boundaries between different subject areas. The 
workbook attempts to enhance these endeavours by giving higher priority and space to opportunities 
for contemplation and wondering, discussion in small groups and activities requiring hands-on- 
experience. We hope these measures will take us significantly further in the direction of a child- 
centred system of education outlined in the National Policy of Education(1986). 

 
The success of this effort depends on the steps that school Principals and Teachers will take to 
encourage children to reflect their own learning and to pursue imaginative and on-the-job activities 
and questions. Participation of learners in skill development exercises and inculcation of values and 
creativity is possible if we involve children as participants in learning, and not as receiver of 
information. These aims imply considerable change in school routines and mode of functioning. 
Flexibility in the daily time-table would be a necessity to maintain the rigour in implementing the 
activitiesandtherequirednumberofteachingdayswillhavetobeincreasedforteachingandtraining. 
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This workbook is to assist you with completing the Unit of Competency “3D Production Pipeline”. You 
should work through the workbook in the classroom, at the workplace or in your own time under the 
guidance and supervision of your teacher or trainer. This workbook contains sessions which will help 
you to acquire relevant knowledge and skills (soft and hard) on various aspects of the unit of 
competency. Each session is small enough to be easily tackled and digested by you before you move on 
to the next session. Animated pictures and photographs have been included to bring about visual 
appeal and to make the text lively and interactive for you. You can also try to create your own 
illustrations using your imagination or taking the help of your teacher. Let us now see what the sections 
in the sessions have foryou. 

 
Section 1: Introduction 

 
This section introduces you to the topic of the Unit. It also tells you what you will learn through the 
various sessions covered in the Unit. 

 
Section 2: Relevant Knowledge 

 
This section provides you with the relevant information on the topic(s) covered in the session. The 
knowledge developed through this section will enable you to perform certain activities. You should 
read through the information to develop an understanding on the various aspects of the topic before 
you complete theexercise(s). 

 
Section 3: Exercise 

 
Each session has exercises, which you should complete on time. You will perform the activities in the 
classroom, at home or at the workplace. The activities included in this section will help you to develop 
necessary knowledge, skills, and attitude that you need for becoming competent in performing the 
tasks at workplace. The activities should be done under the supervision of your teacher or trainer who 
will guide you in completing the tasks and also provide feedback to you for improving your 
performance. To achieve this, prepare a timetable in consultation with your teacher or trainer and 
strictly adhere to the stipulated norms or standards. Do not hesitate to ask your teacher or trainer to 
explain anything that you do not understand. 

 
Section 4: Assessment 

 
The review questions included in this section will help you to check your progress. You must be able to 
answer all the questions before you proceed to the next session. 
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Introduction  
 

2D animation figures are created or edited on the computer using 
2D bitmap graphics or using 2D vector graphics. This includes 
automated computerized versions of traditional animation 
techniques,     such     as interpolated morphing,      onion  
skinning and interpolated rotoscoping. 2D animation has many 
applications, including analog computer animation, Flash 
animation and Power Point animation. The 2D production pipeline 
starts with workbook and goes all the way through final checking, 
compositing and final output in the form of an animatedfilm. 

 

 

3D Production Pipe-Line 

A 3D animation is essentially a digital version of 2D animation. 3D 
animators create poses on a series of still images that are referred to 
as frames. By creating a series of poses and playing it over a certain 
amount of frames you can create the illusion of movement. 3D 
animation is digitally modelled and manipulated by an animator. 
The 3D Computer Generated Image (CCI) production process 
emphasizes the importance of a smooth production path. It covers 
design, modelling and rigging steps through touch up and final 
output in the form of a video or film. 

 
In  3D  animation,  the  animator  usually  starts  by  creating  a  
3D polygon mesh to manipulate. A mesh typically includes many 
vertices that are connected by edges and faces, to give the visual 
appearance of form to a 3D object or 3D environment. Sometimes, 
the mesh is given an internal digital skeletal structure called an 
armature that can be used to control the mesh by weighting the 
vertices. This process is called rigging and can be used in 
conjunction with key frames to createmovement. 

 
As a student, you should know the basics of a 3D production 
pipeline, before you start learning about the various other 
complex techniques in animation. It will help you in understanding 
the production process and the role of various people involved in 
3D animation. The first process in the animation pipeline, and 
alsoone of the most important, is the pre-production. It begins 
withthe main concept or idea, which is turned into a full story 
througha storyboard and then, once the story has been finalized, 
otherthings such as the shot sequence and camera angles are 
workedout. Some of the major components of pre-production are 
storyboarding, layouts, model sheets and animatics. Pre- 
production process is followed by production and post production 
steps, which involves design, modeling, rigging, staging, 
animation, lighting, effects, rendering, composite, touchup and 
final film/video output. In this Unit, you will learn about the 
various terms and stages of 3D animation production line. It will 
help you in building your foundation for developing a 3D animated 
film. 
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Relevant Knowledge  
Pre-production is the phase of developing ideas and planning prior 
to the process of production. It begins with the main concepts or 
ideas which are initially turned into a full story, and then, once 
the story has been finalized, other things such as the script, shot 
sequence and camera angles are worked out. It is the period 
before any real animation work takesplace. 
 
In this session, you will learn about the different steps involved in 
the pre-production process and how each step helps to develop a 
foundation on which further production stages are built. The work 
done during the pre-production serves as a visual reminder of the 
original plan; something that can be referred back to throughout 
the production. 
 
The major components of a pre-production process are as follows: 
 
1. StoryBoarding 
2. Layouts 
3. ModelSheets 
4. Animatics 

Session 1:Pre-Production  
 

In this session you will learn how to perform pre-production activities. 
 

 

Storyboard 
 

The storyboard helps to finalize the development of the storyline, 
and is an essential stage of the animation process. It is made up of 
drawings in the form of a comic strip, and is used to both help 
visualise the animation and to communicate ideas clearly. 
Storyboards often include notes to describe the frame in more 
detail, such as mood and lighting, as well as camera moves. It 
details key events and scene changes in the animation, often 
accompanied by text notes describing what is occurring in the 
scene such as camera movements. It is a visual reminder of the 
plan and can be referred back to throughout the production stage. 
Storyboards can be especially useful when working in group 
environments, something quite common in the animation industry. 

 
Character Design 

 
Character design involves developing the appearance and features 
of characters in an animation. Model Sheets and Expression 
Sheets are produced to help animators be consistent with the 
appearance of characters. Character Line-up Sheets are also 
produced to compare the scale of the characters against one 
another. 
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Ananimaticisatimedmovingversionofthestoryboardmadeup 
of individual frames taken from the storyboard and is often 
accompanied by audio such as dialogue, sound effects and music. 
Each frame of the animatic depicts a certain key point of the 
scene or movie. The running time should match the intended 
running time of the final animation. Animatic can assist with 
decisions regarding scenes to include or exclude. On acommercial 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Layouts 
 

Once the storyboards have been approved, they are sent to the 
layout department which then works closely with the director to 
design the locations and costumes. With this, they begin to stage 
the scenes, showing the various characters' positions throughout 
the course of each shot. 

 

Model Sheets 
 

Model sheets are precisely drawn groups of pictures that show all 
of the possible expressions that a character can make, and all of 
the many different poses that they could adopt. These sheets are 
created in order to both accurately maintain character detail and 
to keep the designs of the characters uniform whilst different 
animators are working on them across several shots. During this 
stage the character designs are finalized so that when production 
starts, their blueprints can be sent to the modelling department 
who are responsible for creating the final character models. 

 

Expression Sheets may also be developed as a guide to character 
facial expressions, such as, smiling, laughing, sad, shocked, 
startled, sleepy, alert, thoughtful, concerned, etc. 

 
Animatic 
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1. Fill in the blanks in the flow chart shown for 3D Animation ProductionCycle 
 

 
2. Develop your ownstoryboard 

 
 Take a short piece of text, illustrating a scenario. For example a nursery rhyme is a good 

starting point if storyboarding is an unfamiliartask. 
 Breakdownthestory,linebylineintoaseriesofimagesthatrepresenttheactionstaking place in 

thestory. 
 Draw these images on to storyboardframes 
 Writethedialogueundertheimagesandaddanydetailsofsoundeffectsthatmightcontribute to the 

dramaticscene. 
 Use variety of different angles to illustrate the story, such as close ups and wideangles. 
 Discusshowusingavarietyofshotscreatesdramaandvisualinteresttothestory You can 

use the template given below for developing youstoryboard. 

project this is very important as it avoids wastage of time and 
money during production. These help the Director plan how they 
will go about staging the above sequences, as well as how visual 
effects will be integrated into the final shot. 

Exercise 
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Create a short storyboard in the format given below: 
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Answer the following questions 

 
1. What is the purpose of ModelSheet? 

 
 
 
 
 
 
 

2. What isAnimatics? 
 
 
 
 
 
 

Use the following checklist to see if you have met all the requirements for assessment activity: 
 

Part A 

Differentiated between the following: 
 

1. Story boarding andlayouts 
2. Model sheets andanimatics 

 
Part B 

Discussed in class the following: 
 

1. How to create astoryboard? 
2. What are the model sheets andanimatics? 
3. What is the use of modelsheets? 

 
Part C 

Performance standards 
 

The performance standards may include, but not limited to: 
 

Performance Standards Yes No 
Develop a Storyboard   

Demonstrate the knowledge of character design   

Draw a model sheet of a character   

Assessment 

Checklist for Assessment Activity 
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Session 2: Production -I  
 

In this session you will learn about creating model for stop motion 3D animation and Texture a 
character. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

A layout is a visual map. It instructs the various artists on a scene 
where the characters are to be positioned and how they are to 
move. The timing of the scene and individual character 
movements will be indicated on the “dopesheet”. A dopesheet 
looks a little like a spreadsheet with rows and columns but its 
purpose is to provide instructions concerning the time duration of 
individual character movements, scenes, camera moves and audio 
details. It ensures that each and every person working on a 
production is working to the same basic instructions. 

 
A Layout Artist set the stage for each scene of animation. The 
Layout Artist produces the 3D version of what storyboard artists 
had previously drawn on paper. Each layout is a vital piece of 
reference for all those involved in the production process. The 
layout determines lighting and camera angles as well as where 
characters and props are placed in the scene according to their 
start positions. The Layout Artist will often work closely with the 
Director and other specialists such as a Scene Planner and Special 
Effects Supervisor to work out the scene layout. 

 
WhiletheLayoutArtistisresponsibleforcomposingtheshotand 
delivering rough animation to the animators as a guide, the 
Background Artist creates scene settings. A background is 
essentiallyastaticsettinguponwhichtheanimationtakesplace 

Relevant Knowledge 
 
Production 
 
Now that the storyboard has been approved, the project enters 
the production phase. It is here that the actual work can start, 
based on the guidelines established during pre-production. Some 
major activities that are undertaken during the production phase 
are the layout, modelling, texturing, lighting, rigging, and 
animation. Animation production is a very coordinated process 
where different teams of artists work together while utilizing 
optimum resources and achieving the initial goal in the time 
available. The production phase is often the longest and busiest 
phase of the animation project. During this stage the Director 
approves camera moves, depth of field and the composition of 
the models making up the set and set dressing. It is then the 
responsibility of the Modelling department to deliver these 
approved set, prop and character models in the final layout 
stages. A 2D production pipeline starts with workbook and goes  
all the way through final checking, composting and film output, 
whilst the 3D production process emphasizes the design, 
modelling and rigging and animationstages. 
 
Layout 
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in the foreground. Background images can be very simple and 
drawn in a similar flat style to the characters. The Key Frame 
Animators draw the images that determine the beginning of a 
movement and the end of movement.  The  Inbetween  
animators draw the images or frames inbetween the key frames 
to complete the movements prescribed by the Key Frame 
Animator. The process of colouring of animation frames is carried 
out by Digital Ink and Paint Artist using specialist ink and paint 
software. Clean-up Artists are responsible for re-drawing the Key 
Frame and Inbetween Animators drawings which are normally of a 
rough linequality. 

 
The Scanner Operator is responsible for scanning drawings 
prepared by the Clean-up Artist. Ink and Paint, which is the 
process of colouring the drawn frames is used to transfer drawings 
over to cels which are then hand painted. However, in the digital 
age the term is often referred to as Digital Ink and Paint as the 
process now involves scanning the finished drawings into a 
computer where they can be coloured using a software package. 
The scanned cels can be coloured in or 'inked' using simple tools 
such as the 'Paint Bucket', a tool which is common to many 
software packages. It is also possible to touch up the scanned line 
drawings using tools such as the Paintbrush. 

 
Line Test 

 
A Line Test is a process used to check hand drawn frames prior to 
them being used for final artwork. Frames are captured either via 
a video camera, frame by frame or by scanning them into a 
computer. The resulting sequence allows the animator to assess 
how well the sequence is flowing. If the result is unsatisfactory 
then the animator can simply re-draw, add or delete frames and 
then create another line test. 

 
Onion Skinning 

 
Onion Skinning is a method used to view several frames of an 
animation simultaneously, it allows the animator to check the 
changes occurring within each frame and how they flow together. 
Traditionally this process involved comparing drawn frames on a 
light box but many animation software packages include the 
ability to preview frames with several previous and upcoming 
translucent framesvisible. 

 
Walk Cycle / Loops 

 
The 'Walk Cycle' form of loop is where the sequence of frames 
used to show one foot moving in front of another can be repeated 
continually and gives the effect of continuous walking. Walk 
Cycles are a common form of 'loop' animation, they consist of a 
sequence of frames which together make a continuous flowing 
loop. They help to make repetitive movements simpler to 
animate. 
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Modelling 
 
Working closely with the Art Directors, Visual Effects Supervisors 
and Animation Supervisors, Modellers turn the 2D concept art and 
traditionally sculpted maquettes into high detail, topologically 
sound 3D models. They then assist the Technical Animator and 
Enveloper as the model has a skeleton put in place and the skin is 
developed. Following this, the model may be handed back to the 
Modeller, who will proceed to sculpt facial expressions and any 
specific muscle tension/jiggle shapes that may be required. 
 
Modellers are usually split into two or more departments. Whilst 
Organic Modellers tend to have a sculpture background and 
specialise in building the characters and other freeform surfaces, 
Hard-surface Modellers often have a more industrial design or 
architectural background, and as such they model the vehicles, 
weapons, props, and buildings. 

Once the model is approved, it will be made available to the 
rigging and texture paint departments, who complete the final 
stages in preparing the model for animation and rendering. The 
model will move through the production pipeline without coming 
back for modelling fixes, although some amount of fixes are 
inevitable - problems with models sometimes don't appear until 
the rendering stage, in which case the lighter will send the model 
back to be fixed. 
 
Whether creating a texture from scratch or through editing an 
existing image, the Texturing Artists are responsible for writing 
shades and painting textures as per the scene requirements. 
Working hand-in-hand with the surfacing and shading 
departments, textures are painted to match the approved 
concept art and designs which were delivered by the art 
department. These textures are created in the form of maps 
which are then assigned to themodel. 
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Texturing 
 

Lighting Technical Directors make sure there is consistency in 
lighting, colour balance and mood between the various elements 
of a shot or scene. When appropriate, they ensure the computer- 
generated imagery looks photorealistic to match the live action 
plates. They combine the latest version of the animation, the 
effects, the camera moves, the shaders and textures, and render 
out an updated version every day. 

 
 

 
1. Preformlayoutanimationbyapplyingtweeningtoeachviewthatispartofthelayoutbeing 

animated. Here are four types of tweening animation that you canperform: 
 

 Scale animation: to make a view smaller or larger either on x axis or on the yaxis. 
 Rotate animation: to rotate a view around a pivot point by a certain number ofdegrees. 
 Translate animation: to move a view along the x or yaxis. 
 Alpha animation: to change the transparency of aview. 

Exercise 
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Answer the following questions 
 

1. What is 3Dmodeling? 
 
 

 
 
 
 
 

2. What istexturing? 
 
 

 
 
 
 

3. Write the roles and functions of thefollowing: 
 

1. LayoutArtist 
 

2. BackgroundArtist 
 

3. Key-frameAnimator 
 

4. In betweenAnimator 
 

5. Clean-upArtist 
 

6. ScannerOperator 
 
 

 
 
 
 
 
 
 
 
 

Assessment 
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Use the following checklist to see if you have met all the requirements for assessment activity: 
 

Part A 
 

Differentiated between the following: 

1. Modeling and texturing 
 

Part B 
 

Discussed in class the following: 
 

1. How to model a character inanimation? 
2. What is UV stage inmodelling? 
3. How to paint textures inanimation? 
4. What isrendering? 

 
Part C 

 
Performance standards 

 
 

The performance Standard may include, but not limited to: 
 

Performance Standards Yes No 
Demonstrate the knowledge of layout   

Demonstrate the knowledge of onion skinning   

Demonstrate the knowledge of modelling and texturing   

Checklist for Assessment Activity 
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Session 3: Production -2  

In this session you will learn about the concept of Lighting and Rigging & the use of concept of lighting 
to create a bright image 

 

 

 

 
Lighting 

Not only does a Lighting Artist have to think lighting the individual 
scenes, they also have to consider how to bring together all of the 
elements that have been created by the other departments. In 
most companies, lighting TDs combine the latest version of the 
animation, the effects, the camera moves, the shades and 
textures into the final scenes, and render out an updated version 
everyday. 

Lighters have a broad range of responsibilities, including placing 
lights, defining light properties, defining how light interacts with 
different types of materials, the qualities and complexities of the 
realistic textures involved, how the position and intensity of lights 
affect mood and believability, as well as color theory and 
harmony. They are required to establish direct and reflected 
lighting and shadows for each assigned shot, ensuring that each 
shot fits within the continuity of a sequence, all the while aiming 
to fulfil the vision of the Directors, Production Designers, Art 
Directors and VFX Supervisors. 
 
Rigging 

Rigging is the process of adding bones to a character or defining 
the movement of a mechanical object, and it's central to the 
animation process. A character TD will make test animations 
showing how a creature or character appears when deformed into 
different poses, and based on the results corrective adjustments 
are often made. The rigging department is also involved in 
developing cloth simulation – so as well as making a character able 
to clench their fist or rotate their arm, the rigging and cloth 
department is responsible for making their costume move in a 
believable manner. Planning a character's performance frame by 
frame uses the same basic principles first developed for 2D 
animation. 

Relevant Knowledge 
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In modern production companies, the practice of meticulously 
planning a character's performance frame by frame is applied in 
3D graphics using the same basic principles and aesthetic 
judgments that were first developed for 2D and stop-motion 
animation. If motion capture is used at the studio to digitize the 
motion of real actors, then a great deal of an animator's time will 
also be spent cleaning up the motion captured performance and 
completing the portions of the motion (such as the eyes and 
hands) that may not have been digitized during theprocess. 
 

The effects team also produce elements such as smoke, dust, 
water, and explosions, although development on these aspects 
does not start until the final animation/lighting has been  
approved as they are integral to the final shot and often 
computationallyheavy. 
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1. Observe20differentimagesof3Dlighting,riggedcharacterandanimationscenes,givenbythe 
instructor. List your observations, with rationale, for eachimage. 

 
2. Fill in the blanks in the flow chart shown for 3DAnimation 

 
 

 
 

Answer the following questions: 
 

1. What is 3Dlighting? 
 
 

 
 
 
 
 

Exercise 

Assessment 
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2. What is the use of rigging in productionpipeline? 
 
 

 
 
 
 
 
 

3. What is 3Danimation? 
 
 

 
 
 
 
 
 
 

 

Use the following checklist to see if you have met all the requirements for assessment activity: 
 

Part A 
 

Differentiated between the following: 
 

1. Lighting, rigging andanimation 
2. 3D Lighting and 3Danimation 

 
Part B 

 
Discussed in class the following: 

 
1. How lighting is done in an animatedmovie? 
2. How rigging is done to animate acharacter? 

 
Part C 

 
Performance standards 

 
The performance Standard may include, but not limited to: 

 
Performance Standards Yes No 
Explain the relation between the various departments of production pipeline   

Demonstrate the knowledge of lighting, rigging and animation   

Checklist for Assessment Activity 
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Session 4:Post-Production  
 

In this session, you will learn how to perform post-production activities and prepare a flow chart of 
post production activities and required materials/ equipments. 

 
 
 
 
 
 
 
 
 
 
 
 

Rendering 
 

The rendering stage is usually associated with computer- 
generated animation, although rendering can also refer to the 
process of creating final animation frames in traditional hand- 
drawn animation. Rendering is used in both 2D and 3D computer 
animation. It is the process of getting the final assembled 
animation scenes or pieces out of the computer in the format of a 
sequence of individual frames. The aim of rendering is to generate 
a series of individual pixel based frames or a videoclip. 

 

The Compositing Department brings together all of the 3D 
elements produced by the previous departments in the pipeline, 
to create the final rendered image ready for film. After the 
animation has been rendered it may be necessary to add some 
special effects or to combine separate rendered elements 
together into one final animated sequence. This process is known 
as Compositing. Compositors are responsible for constructing the 
final image by combining layers of previously-created material. 
They receive material from various sources including rendered 
computer animation, special effects, graphics, 2D animation, live 
action and static background plates. The compositor's job is to 
assemble the different characters and backgrounds into single 
frames and sequences and so is often the first to begin to see the 
animation as intended for the final audience. The compositing 
stage also allows for the addition of other elements such as 
special effects which have been created using other equipment 
andprocesses. 

Relevant Knowledge 

 
Compositing 

 
General compositing tasks include rendering the different passes 
delivered by a lighting department to form the final shot, paint 
fixes and rotoscoping (although compositors sometimes rely on 
mattes created by a dedicated rotoscoping department), as well 
as the compositing of final elements and general colourgrading. 

 
Post-production is the third and final step in film creation and it 
refers to the tasks that must be completed or executed after the 
filming or shooting ends. It involves exporting or rendering out 
the animation frames and then editing the pieces of animation 
together using video editing software. It includes the editing of 
raw footage to cut scenes together, inserting transitional effects, 
working with voice and sound actors and dubbing to name just a 
few of the many post-production tasks. 
 
The three main phases of post-production are rendering, 
compositing, sound editing, and video editing. 



18  

 
Editing 

 
The editing stage of post-production involves putting the rendered 
pieces of our animation together in the correct order of events. In 
this modern digital age this means the use of digital non-linear 
video editing software which allows a great deal of flexibility in 
the editing process. In the past the editing process would have 
involved the use of video-tape or film based methods which were 
considerably more time-intensive and less flexible. 

 
Digital editing offers the benefit of being able to work in a 
completely digital environment regardless of the final output 
format. One benefit of digital editing is that it is achievable using 
any latest desktop computer. 

 

Post-production sound editing primarily involves preparing the 
sound track for import into the video editing software, this may 
involve adjustments to the sequence or occurrence of particular 
sounds due to changes made in the editing stage. Editing the 
Sound track can be a separate process to editing the video track, 
although these are combined together within the video editing 
software. The sound track at this stage is already assembled in a 
fairly complete form having been created in the Production stage. 
Many sound changes may take place simply within the Video 
Editing software itself and may not require much, if any, changes 
to made within the Sound Editing software. Editing Assistants 
support the Editor and editing department in editing  process. 
They make viewing copies on different formats for various 
departments, clients and composers. They handle the 
housekeeping tasks for the editing department, keeping it stocked 
with relevant materials, ensuring that all equipment is in good 
working order and placing orders with outsidesuppliers. 

 
Sound and Music Score 

 
The sound and music score or soundtrack, is an important part of 
the animation production process. The use of audio, such as 
music, sound effects and vocal dialogue all play a big part in 
telling the story. Altering the type of sound used, particularly the 
choice of music or background ambience will have an effect on 
the mood of an animation. The editing department is responsible 
for selecting and assembling the sound recordings in preparation 
for the final sound mix, ensuring lip sync and adding all of the 
sound effects required for the finalfilm. 

 

Editing is a crucial step in making sure the video flows in a way 
which achieves the initial goal. Video editing is the process of 
manipulating and rearranging shots to create a seamless final 
product, and it is at this stage that any unwanted footage and 
scenes are removed. Other tasks include titling and adding any 
effects to the final video and text. 
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Titles and Credits 
 

Titles and Credits are an important part of a finished animation. It 
helps in people know who made it, when it was made, who funded 
the project and so on. This may involve adding text or subtitles at 
various points if appropriate. 

 
 
 

1. Observe 20 different images of before and after composited and edited scenes, given by the 
instructor. List your observations, with rationale, for each image. 

 

 
Answer the following questions: 

 
1. What isPost-production? 

 
 

 
 
 
 
 
 

2. What iscompositing? 
 
 

 
 
 
 
 
 

3. What isediting? 
 
 

 
 
 

Exercise 

Assessment 
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Use the following checklist to see if you have met all the requirements for assessment activity: 
 

Part A 
 

Differentiated between the following: 
 

1. Sound editing and video editing 
 

Part B 
 

Discussed in class the following: 
 

1. What is the purpose ofcompositing? 
2. Why video and sound editing is required to make amovie? 

 
Part C 

 
Performance standards 

 
The performance Standard may include, but not limited to: 

 
Performance standards Yes No 

Demonstrate the knowledge of post-production procedure   

Demonstrate knowledge of compositing, sound and video editing   

Checklist for Assessment Activity 
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1. Angle of View -The viewable field covered by a lens, 
measured indegrees. 

2. Animatics - A preliminary version of a television commercial 
in which animated cutout figures are used instead of live 
participants and realobjects. 

3. Animation -The process of creating a progressively altering 
image that gives the appearance of continuousmotion. 

4. Compositing -The process of combining multiple elements 
shot separately (still images, movie clips) into a final image 
or sequence to give the impression they were all shot at the 
sametime. 

5. Effects animation -The animation of non-character elements 
such as explosions, smoke andrain. 

6. High definition (HD) -A general term for a video signal with a 
significantly higher resolution than standarddefinition. 

7. Layout- The art or process of arranging printed or graphic 
matter on apage. 

8. Model sheets - Model sheets are also used for references in 
3D modelling. It usually is used as reference material so as to 
allow proper proportions in 3Dmodelling. 

9. Story Boarding - A panel or series of panels of rough  
sketches outlining the scene sequence and major changes of 
action or plot in a production to be shot on film orvideo. 

 

Books 
1. Inspired 3D Short Film Production by Jeremy Cantor, PepeValencia 
2. Production Pipeline Fundamentals for Film and Games by ReneeDunlop 
3. Guide to Postproduction for TV and Film: Managing the Process by Barbara Clark, SusanSpohr 
4. The Art and Science of Digital Compositing, Second Edition: Techniques for Visual Effects, 

AnimationandMotionGraphics(TheMorganKaufmannSeriesinComputerGraphics)byRon 
Brinkmann 

5. Digital Compositing for Film and Video by SteveWright 
6. The Technique of Film and Video Editing: History, Theory, and Practice by KenDancyger 

 
Websites 
1. http://www.wideopenspace.co.uk/animation-tutorial/s6-how-to-guide.html 
2. http://cgi.tutsplus.com/articles/step-by-step-how-to-make-an-animated-movie--cg-3257 
3. http://www.cs.dartmouth.edu/~fabio/teaching/projects10/lectures/01_pipeline.pdf 
4. http://creativeskillset.org/ 
5. http://www.animationmagazine.net/ 
6. http://www.awn.com/ 
7. http://www.animationnation.com/ 
8. http://www.creativebloq.com/3d-world-magazine 
9. http://blog.digitaltutors.com/understanding-a-3d-production-pipeline-learning-the-basics/ 
10. https://bigcostas.wordpress.com/3d-production-pipeline/ 
11. http://3d.about.com/od/3d-101-The-Basics/tp/Introducing-The-Computer-Graphics-Pipeline.htm 
12. http://en.wikipedia.org/wiki/Post-production 
13. http://www.raindance.org/the-13-steps-of-post-production/ 
14. http://en.wikipedia.org/wiki/Video_editing 

Suggested Reading 

Glossary 

http://www.wideopenspace.co.uk/animation-tutorial/s6-how-to-guide.html
http://cgi.tutsplus.com/articles/step-by-step-how-to-make-an-animated-movie--cg-3257
http://www.cs.dartmouth.edu/~fabio/teaching/projects10/lectures/01_pipeline.pdf
http://creativeskillset.org/
http://www.animationmagazine.net/
http://www.awn.com/
http://www.animationnation.com/
http://www.creativebloq.com/3d-world-magazine
http://blog.digitaltutors.com/understanding-a-3d-production-pipeline-learning-the-basics/
http://3d.about.com/od/3d-101-The-Basics/tp/Introducing-The-Computer-Graphics-Pipeline.htm
http://en.wikipedia.org/wiki/Post-production
http://www.raindance.org/the-13-steps-of-post-production/
http://en.wikipedia.org/wiki/Video_editing
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 Preface  
 

The National Curriculum Framework, 2005, recommends that children’s life at school must be linked 
to their life outside the school. This principle makes a departure from the legacy of bookish 
learning which continues to shape our system and causes a gap between the school, home, 
community, and theworkplace. 

 
The student workbook is a part of the qualification package developed for the implementation of 
National Vocational Education Qualification Framework (NVEQF), an initiative of Ministry of Human 
Resource Development (MHRD), Government of India to set common principles and guidelines for a 
nationally recognized qualification system covering Schools, Vocational Education and Training 
Institutions, Technical Education Institutions, Colleges and Universities. The NVEQF was  subsumed 
in National Skills Qualifications Framework (NSQF) in 2013. It is envisaged that the NSQF will 
promote transparency of qualifications, cross-sectoral learning, and student-centred learning and 
facilitate learner’s mobility between different qualifications, thus encouraging lifelonglearning. 

 
This student workbook, which forms a part of vocational qualification package for students who 
have passed Class IX or equivalent examination, was created by a group of experts. The Media and 
Entertainment Sector Skill Council approved by the National Skill Development Corporation (NSDC) 
for the Media and Entertainment Industry developed the National Occupational Standards (NOS) and 
the Qualification Pack (QP) for the job role. The National Occupational Standards are a set of 
competency standards and guidelines endorsed by the representatives of Media & Entertainment 
Industry for recognizing and assessing skills and knowledge needed to perform effectively in the 
workplace. 

 
The Pandit Sunderlal Sharma Central Institute of Vocational Education (PSSCIVE), a constituent of 
National Council of Educational Research and Training (NCERT) has developed modular curricula  
and learning materials (Units) for the vocational qualification package in Media and Entertainment 
sector for NSQF levels 1 to 4; level 1 is equivalent to Class IX. Based on NOS, occupation related 
core competencies (knowledge, skills, and abilities) were identified for development of curricula 
and learning modules(Units). 

 
This student workbook attempts to discourage rote learning and to bring about necessary flexibility 
in offering of courses, necessary for breaking the sharp boundaries between different subject areas. 
The workbook attempts to enhance these endeavours by giving higher priority and space to 
opportunities for contemplation and wondering, discussion in small groups and activities requiring 
hands-on- experience. We hope these measures will take us significantly further in the direction of 
a child- centred system of education outlined in the National Policy of Education(1986). 

 
The success of this effort depends on the steps that school Principals and Teachers will take to 
encourage children to reflect their own learning and to pursue imaginative and on-the-job activities 
and questions. Participation of learners in skill development exercises and inculcation of values and 
creativity is possible if we involve children as participants in learning, and not as receiver of 
information. These aims imply considerable change in school routines and mode of functioning. 
Flexibility in the daily time-table would be a necessity to maintain the rigor in implementing the 
activities and the required number of teaching days will have to be increased for teaching and 
training. 

 
(vi) 
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About Your Workbook 
 
 

The student workbook contains sessions which will help you to acquire relevant knowledge and 
skills (generic and domain-specific skills) related to the job role. Each session is small enough to be 
easily tackled and digested by you before you move on to the next session. Animated pictures and 
photographs have been included to bring about visual appeal and to make the text lively and 
interactive for you. You can also try to create your own illustrations using your imagination or 
taking the help of yourteacher. 

 
Let us now see what the sections in the sessions have for you. 

 
Section1: Introduction 

 
This section introduces you to the topic of the Unit. It also tells you what you will learn through the 
various sessions covered in the Unit. 

 
Section 2: Relevant Knowledge 

 
This section provides you with the relevant information on the topic(s) covered in the session. The 
knowledge developed through this section will enable you to perform certain activities. You should 
read through the information to develop an understanding on the various aspects of the topic 
before you complete theexercise(s). 

 
Section 3: Exercise 

 
Each session has exercises, which you should complete on time. You will perform the activities in 
the classroom, at home or at the workplace. The activities included in this section will help you to 
develop necessary knowledge, skills and attitude that you need for becoming competent in 
performing the tasks at workplace. The activities should be done under the supervision of your 
teacher or trainer who will guide you in completing the tasks and also provide feedback to you for 
improving your performance. 

 
Section 4: Assessment 

 
The review questions included in this section will help you to check your progress. You must be 
able to answer all the questions before you proceed to the nextsession. 
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Introduction  

 

Like any other skill, editing has some basic rules that help us to 
understand what the filmmaker and editor wants to say. Take some 
time to study films and TV so you can learn these. What you add to 
the image and sound after it is filmed can hugely influence a film. 
You must have noticed in movies that tension is indicated by music 
and close up shots on actors. Different camera angles break the 
scene down and make it interesting by leading the viewer‘s eye to 
what is important. The way you cut between these, i.e. fast or 
slow, is also telling the audience more information about the story. 
The editors can alter everything about the film with theirskills. 

 
Understanding modern techniques of editing is the key to the 
success of the film, if your audience is to follow what you mean 
with your edits. Watch lots of movies and examine how cuts are 
made. How do scenes end, what does a cut to black signify or a 
slow dissolve mean? Editing styles can alter the feel of your film. 
Short snappy cuts give the film a tense, fast pace. Long gaps 
between cuts allow time for the audience to relax into the scenes. 
Clever editing can create illusions; just the sound of a helicopter 
creates the illusion that there really is a helicopter just out of shot. 
Editing can also help smooth over problems, you can edit around a 
difficult interview by cutting out bits. If you need to show more 
than one aspect of a scene, you can film the scene several times 
from different angles and in the edit cut between thoseangles. 

 
Montage is the principle underlying all editing. The audience is 
trying to interpret your film as they watch, create meanings from 
the images and sounds you play them. If for example, you put 
together a politician‘s speech without sound, followed by images of 
war, then the politician is assumed to be talking about war. 
Montage creates a new meaning from two independent images. 
Similarly you can lead the audience this way, show separate images 
of two people walking down a street and the audience will assume 
the two will eventuallymeet. 

 
In this Unit, you will learn about the working procedure of a video 
editing software known as Adobe Premiere Pro and a sound editing 
software known as Adobe Sound Booth. 
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Session 1: Introduction to Adobe PremierePro  

In this session you will learn about the use of tool box of Adobe Premiere Pro. 

RelevantKnowledge  
Adobe Premiere Pro is a video editing software that can capture, 
edit, perform special effects, add graphics and titles, all the way 
to final production. Using the Adobe Premier Pro you will learn a 
series of steps for creating, editing and fine-tuning various video 
pieces. 

 
About Workspaces 

 
When you work with Adobe Premier Pro, it presents a virtual 
workspace on the screen. You can move windows around, close 
some items and open others. 

 
To begin, start by launching Adobe Premier Pro, Click Start 
All  Programs Adobe Premier Pro, then click on the New Project. 

 
Adobe video and audio applications provide a consistent, 
customizable workspace. Although each application has its own 
set of panels (such as Tools, Properties, Timeline, and so on), you 
move and group panels in the same way acrossproducts. 

 
The main window of a program is the application window. Panels 
are organized in this window in an arrangement called a 
workspace. The default workspace contains groups of panels as 
well as panels that standalone. 

 
You customize a workspace by arranging panels in the layout that 
best suits your working style. You can create and save several 
custom workspaces for different tasks—for example, one for 
editing and one forpreviewing. 

 
You can drag panels to new locations, move panels into or out of a 
group, place panels alongside each other, and undock a panel so 
that it floats in a new window above the application window. As 
you rearrange panels, the other panels resize automatically to fit 
the window. 

 
You can use floating windows to create a workspace more like 
those in previous versions of Adobe applications, or to place 
panels on multiple monitors. 
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Example of Workspace 
 

 
 

A. Applicationwindow 

B. Grouped panels 

C. Individual panel 

Tools 

The Tools panel contains a number of tools for editing sequences 
in the Timeline panel. When you select a tool, the pointer changes 
shape according to the selection. For example, when you select 
the Razor tool and position the pointer over a clip in the Timeline 
panel, the icon changes to a razor. However, the Selection tool 
icon may change to reflect the task currently being performed. In 
some cases, pressing a modifier key (such as Shift) as you use a 
tool changes its function, and its icon changes accordingly. Select 
tools from the Tools panel, or use a keyboard shortcut. You can 
resize the Tools panel and orient it vertically orhorizontally. 

 
Note: The Selection tool is the default tool. It is used for 
everything other than specialized functions. If the programme is 
not responding as you expect, make sure that the Selection tool is 
selected. 

 
Toolbox 

 

 
 

A. Selectiontool 
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B. Track Selectiontool 

C. Ripple Edittool 

D. Rolling Edittool 

E. Rate Stretchtool 

F. Razortool 

G. Sliptool 

H. Slide tool 

I. Pentool 

J. Hand tool 

K. Zoom tool 

AboutProjects 

Every project includes a Project panel. This acts as a storage area 
for all files used in the project. You can organize a project‘s 
media and sequences using bins in the Project panel. 

 
Within a single project file, you can edit individual segments as 
separate sequences, and then combine the segments into a 
finished programme by nesting them in a longer sequence. 
Similarly, you can store multiple variations of a sequence in the 
same project. 

 
Note: There‘s no need to save copies of a project when creating 
different segments or versions of the same video programme. 
Simply create new or duplicate sequences within a single project 
file. 

 
Adobe Premiere Pro does not store video, audio, or still image 
files in the project file—it stores only a reference to each of these 
files based on its filename and location at the time you imported 
it. If you later move, rename, or delete a source file, Adobe 
Premiere Pro cannot find it automatically the next time you open 
the project. In this case, Adobe Premiere Pro displays  the Where 
Is The File dialog box. 

 
Create a Project 

 
In most cases, you can start a project simply by using one of the 
presets provided in the New Project dialog box. The presets 
included with Adobe Premiere Pro include common project types. 
Preserve editing quality by using a preset that conforms to the 
specifications of your original assets. For example, if your project 
uses footage mostly in DV format, use a DV preset. If you need to 
specify lower quality settings for output (such as streaming web 
video), do not change your project settings—instead, change your 
export settings later. 

 
If your computer has a capture card compatible with Adobe 
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Premiere Pro, its own optimized presets may appear in the 
available Presets list. 

 
The project settings must be correct when you create the project 
file. Once a project is created, some project settings, such as the 
time base settings, are locked. This prevents unwanted 
inconsistencies that could result from changing project settings 
later. 

 
Either choose New Project on the Welcome screen that appears 
when Adobe Premiere Pro starts up or, after the application is 
open, choose File > New > Project. 

 
Do one of the following: 

 
To apply a preset, select it from the Available Presets list. 

 
To customize settings, choose the preset that most closely 
matches your source footage, click Custom Settings, and then 
select your specific project settings. For Location, specify where 
you want to store the project ondisk. 

 
Type the name of the project, and then click OK. 

 
Note: Whenever possible, specify a location and name that you 
will not have to change later. By default, Adobe Premiere Pro 
stores rendered previews, conformed audio files, and captured 
audio and video in the folder where you store the project. Moving 
a project file later may require moving its associated files aswell. 

 
 
 

Exercise  
 
 

Open the interface of Adobe Premiere and try to understand the workspace. Practice use of tools on 
saved projects. Write a report on your understanding of the features. 

Assessment  
 

I. Short answerquestions 
 

1. What isWorkspace? 
 
 

 

 

 

 

2. Name the editing Tools of Adobe PremierPro 
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3. Describe the procedure for creating a project in Adobe PremierPro 
 
 

 

 

 

 

II. Fill in the blanks 
 

1. Montage is the principleunderlyingall , as it creates a new meaning from two 

independentimages. 

2. Adobe video and audio applications provide aconsistent,customizable . 
 

3. ThedefaultworkspaceinAdobePremierProcontainsgroupsofpanelsaswellaspanelsthat 
 

 alone. 
 

4. You customize a workspacebyarranging in the layout that best suits your 

working style. 

5. Youcan panels to new locations, move panels into or out of a group, place 

panels alongside each other, and undock a panel so that it floats in a new window above the 

applicationwindow. 

6. The panel contains a number oftoolsfor sequences. 
 

7. Every project in Adobe Premier Proincludesa panel. This acts as a storage 

area for all files used in theproject. 

8. Adobe Premiere Pro doesnot video, audio, or still image files in the project 

file—it stores only a reference to each of these files based on its filename and location at the time 

you importedit. 

 

Checklist for AssessmentActivity  
 

Use the following checklist to see if you have met all the requirements for assessment activity. 
 
Part A 

Differentiated between the following: 
 

1. Grouped panels and Individualpanel 
2. Different tools of Adobe PremierPro 
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Part B 

Discussed in class thefollowing: 

1. Workspace 
2. Creating a project on Adobe PremierPro 

 
Part C 

Performance Standards 

The performance standards may include, but not limited to: 
 

Performance Standards Yes No 
Demonstrated the knowledge of using workspace on Adobe Premier Pro   

Demonstrated the knowledge of the various tools in the Tool Box of 
Adobe Premier Pro 

  

Created a project in Adobe Premier Pro   
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Session 2: EditingVideo  
 

In this session, you will learn about how to edit the video. 

RelevantKnowledge  EditingWorkflow 

You create your project in Adobe Premiere Pro by assembling clips 
into a sequence. The workflow you choose depends on your 
preferences and the needs of your project. Here is a common 
editingworkflow: 

 
1. View and trim source clips in the SourceMonitor 
Use the Source Monitor to view clips that you have captured and 
added to your project. As you view the clips, you can set In and 
Out points for the portion of each clip that you want to use in the 
sequence. 

 
2. Assemble clips into asequence 
Drag each clip individually to the Timeline panel, or automatically 
assemble clips selected in the Project panel. As you add individual 
clips, you can decide whether to add video, audio, or both to your 
sequence. 

 
3. Retrim clips in asequence 
If you did not set precise In and Out points for a clip, or you 
decide to change them, you can retrim the clips in a Sequence tab 
of the Timelinepanel. 

 
4. Adjust clip attributes ifnecessary 
As you assemble your sequence, you may want to change the 
duration or the speed at which the clip plays. 

 
5. Rearrangeclips 
After clips are placed in the Timeline panel, you can rearrange 
how they appear in the sequence. You might need to split a clip to 
use different effects, or extract or move a clip and close any 
resulting gaps in the sequence. 

 
Source Clips, Clip Instances, and Sub clips 

 
You can use clips as source clips, clip instances, sub-clips, or 
duplicate clips. You can edit all types of clips in sequences in the 
same way. The clip types differ in the following ways: 

 
Source (master) clip: The clip is originally imported into the 
Project panel. It is listed in the Project panel only once by 
default. If you delete a source clip from the Project panel, all of 
its instances are alsodeleted. 

 
Clip Instance: It is a dependent reference to a source clip, used in 
a sequence. Each time you add a clip to a sequence, you create 
another instance of the clip. A clip instance uses the name and 
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source file reference used by its source clip. While clip instances 
are not listed in the Project panel, they are differentiated in the 
Source Monitor menu if you open instances there. The Source 
Monitor menu lists instances by name, sequence name, and In 
point. 

 
Subclip: A section of a master clip that references the master 
clip‘s media file. Use subclips to organize and manage your 
projects, especially when you need to use only sections of long 
master clips. 

 
Duplicate clip: An independent copy of a source clip, which you 
create manually using the Edit > Duplicate command. You can also 
create a duplicate clip by importing the same file more than once. 
Unlike a clip instance, a duplicate clip maintains its own reference 
to the original clip‘s source file on disk and exists as an additional 
clip in the Project panel. A duplicate clip is not deleted when you 
delete its original from the Project panel. Master and duplicate 
clips can be renamed independently. 

 
Timeline Panel Overview 

 
You assemble and rearrange sequences in the Timeline panel, 
which represents a sequence graphically, showing clips, 
transitions, and effects. A sequence can consist of multiple video 
and audio tracks running parallel in the Timeline panel. 

Timeline panel 

 
A. Sequencetabs 

B. Timeruler 

C. Videotracks 

D. Audiotracks 

Each sequence in a project can appear as a tab in a single 
Timeline panel, or in a separate Timeline panel. A sequence must 
contain at least one video track and one audio track.Multiple 
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video tracks are used to superimpose clips. 
 

Sequences with audio tracks must also contain a master audio 
track, where the output of regular audio tracks is directed for 
mixing. Multiple audio tracks are used to mix audio. You can 
specify the type of audio channels supported by each audio track 
and decide how they are sent to a Master audio track. To achieve 
even greater control over the mixing process, you can create 
submix tracks. 

Navigate in the Timeline Panel 

The Timeline panel contains several controls for moving through 
the frames of a sequence. 

 
Time navigation controls in the Timeline panel 

 
A. Current‑timedisplay 

B. Current‑timeindicator 

C. Viewing areabar 

D. Work areabar 

E. Timeruler 

F. Zoomout 

G. Zoom slider 

H. Zoomin 
 

Time ruler measures sequence time horizontally, using the 
counting method specified in the project settings (although you 
may toggle to a counting method based on audio samples). Tick 
marks and numbers indicating the sequence time are displayed 
along the ruler and change according to the level of detail at 
which you view the sequence. The time ruler also displays icons 
for markers and the sequence In and Outpoints. 
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Current‑time indicator (CTI) Indicates the current frame displayed 
in the Program Monitor. The current frame displays in the Program 
Monitor. The current‑time indicator is a light blue triangle in the 
ruler. A vertical line extends from the current‑time indicator to 
the bottom of the time ruler. You can change the current time by 
dragging the current‑time indicator. 

 
Current time display Shows the time code for the current frame in 
the Timeline panel. To move to a different time, click in the time 
display and enter a new time, or place the pointer over  the 
display and drag left or right. You can change the display between 
time code and the simple frame count by Ctrl‑clicking (Windows) 
or Command-clicking (Mac OS) the current time in either a  
monitor or the Timelinepanel. 

 
Viewing area bar Corresponds to the visible part of the sequence 
in the Timeline panel. You can change the size and position of the 
viewing area bar to quickly view different parts of the sequence. 
The viewing area bar is located just above the timeruler. 

 
Work area bar Specifies the area of the sequence that you want to 
preview or export. The work area bar is located in the lower 
portion of the time ruler. 

 
Zoom controls Change the scale of the time ruler to increase or 
decrease the number of frames visible within the current viewing 
area. The zoom controls are located at the bottom left of the 
Timeline panel. 

 
Work with Tracks 

 
The video and audio tracks in the Timeline panel are where you 
arrange clips, edit them, and add special effects. You can add or 
remove tracks as needed, rename them, and determine which can 
be affected by a procedure. 

 
Add Tracks 

 
New video tracks appear above existing video tracks, and new 
audio tracks appear below existing audio tracks. Deleting a track 
removes all clips in the track but does not affect source clips 
listed in the Projectpanel. 

 
Note: You can add any number of tracks, limited only by your 
system‘s resources. 

With the Timeline panel active, choose Sequence > Add Tracks. 

In the Add Tracks dialog box, do any of the following: 
To add tracks, type the number of tracks you want to add in the 
Add field for video, audio, and audio submix tracks. 

 
To specify the placement of added tracks, choose an option from 
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the Placement menu for each type of track added. 
 

To specify the type of audio track you want to add, choose an 
option from the Track Type menu for audio and audio submix 
tracks. 

 
Click OK. 

 
Note: An audio track can accept only audio clips that use the 
matching channel type—mono, stereo, or 5.1. If you are not sure 
what kind of audio your clips use, select the clip in the Project 
panel and read its information in the preview area. 

 
 

Exercise  
 

1. Import a video in Adobe Premiere Pro and edit it using tools, effects and transitions. Write down 
the steps followed. 

 

Assessment  
 

Fill in the blanks 
 

1. You usetheSource to view clips that you have captured and added to your 

project. 

2. After clips are placedinthe panel, you can rearrange how they appear in 

thesequence. 

3. Clip isadependentreferencetoasourceclip,usedinasequence.Eachtime 

you add a clip to a sequence, you create another instance of the clip. 

4. Sub-clip is a sectionofa clip that references the master clip‘s mediafile. 

5. clip is an independent copy of a source clip, which you create manually using the Edit > 

Duplicatecommand. 

6. A duplicate clip is not deleted when you delete its originalfromthe panel. 

7. Master and duplicate clipscan be independently. 

8. Each sequence in a  project  can  appearasa in a single Timeline panel, or in a 

separate Timelinepanel. 

9. A sequence must contain atleastone track and one audiotrack. 

10. Multiple tracks are used to superimposeclips. 

11. Time  rulermeasuressequence horizontally, using the counting method 

specified in the projectsettings. 

12. ‑time indicator (CTI) Indicates the current frame displayed in the Program Monitor. 

13. The video and audio tracksin the panel are where you arrange clips, edit 

them, and add specialeffects. 
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Checklist for AssessmentActivity  
Use the following checklist to see if you have met all the requirements for assessment activity. 

 

Part A 

Differentiated between the following 

Source Clips, Clip Instances, and Sub clips 

Part B 
Discussed in the class the following: 

 
1. EditingWorkflow 
2. Timelinepanel 
3. How to work withtracks? 

 
Part C 

Performance Standards 

The performance standards may include, but not limited to: 
 
 

Performance Standards Yes No 
Edited a video using common Editing Workflow in Adobe Premiere Pro   

Listed the functions of Timeline panel in Adobe Premiere Pro   

Demonstrated the application of Timeline panel in Adobe Premiere Pro   
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Session 3: Introduction to Adobe SoundBooth  

In this session you will learn about the various features and applications of Adobe Sound Booth for 
editing sound. 

RelevantKnowledge  Adobe SoundBooth 
 

Before opening Adobe Sound Booth, make sure that all of your 
files are organized. First, create a folder in which to save your 
sound (.wav) files as well as your Adobe Sound Booth project file. 

‖This is your ―project folder.  Always keep a Sound Booth project 
file and its associated .wav files in the same project folder. The 
project folder IS your project. If parts of your project should 
happen to get lost (.wav files, for example) your Adobe Sound 
Booth file may notwork. 

 
Using the Workspace 

 
Start Adobe Sound Booth. Unless you modified the workspace, the 
application should automatically open in the Default workspace. 
The upper-left corner of the default workspace contains the Tools 
panel. The Tools panel contains the most frequently used tools in 
Sound booth: the Time Selection tool, the Frequency Selection 
tool, the Marquee tool, the Lasso tool, the Hand tool and the 
Zoom tool (see Figure 1). 

 
Figure 1: Tools Panel 

 
In the upper-right corner of the interface is a Workspace pop-up 
menu. This menu contains the Default workspace, along with two 
other preset workspaces, Edit Audio To Video and Edit Score To 
Video. Choosing one of these different workspaces changes the 
panel arrangement to suit that particular task. Choose Edit Audio 
To Video to see how the panels are arranged in this workspace. 

 

 
Figure 2: Workspace Menu 
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The Workspace menu contains options for creating new 
workspaces as well as deleting workspaces. To customize your 
workspace, you usually start by moving panels. To move a panel, 
click the panel‘s tab and drag the panel to a different location. As 
you move the panel, purple areas called drop zones appear where 
you can drop the panel and snap it into theinterface. 

 

 
Figure 3: Move the History panel into the Tasks panel and drop 
zones appear where the panel will be placed after you release 

your mouse. 
 

When you are satisfied with the workspace, choose New 
WorkspacefromtheWorkspacepop-upmenu.Typeanamefor 
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your workspace in the New Workspace dialog box and click OK. 
Your custom workspace then appears in the Workspace pop-up 
menu. 

 

 
Figure 4: The New Workspace Dialog Box. 

 
Switch back to the default workspace by choosing Default from 
the Workspacemenu. 

 
Choose File > Open and open 1_1_0_Part2_I_2.wav. Open files 
appear in the Files panel. The Files panel is located in the upper- 
left corner of the default workspace. The waveform of the file 
also appears in the Editor panel in the middle of theworkspace. 

 
Choose File > Open and open 2_2_0_End_e_4.wav. When you have 
two files open, you can switch between them by double-clicking 
the file name in the Files panel or choosing the file name from the 
pop-up menu at the top of the Editor panel. Display the new file 
by double-clicking the name in the Filespanel. 

 

 
Figure 5: Files Panel 

 
Below the Files panel is a group of three panels: Task, Effects,  
and Markers. The Tasks panel contains frequently used tasks, such 
as Auto Compose Score and Change Pitch, and Timing. Choose 
Remove A Sound to see the task‘s menu. Notice that the Editor 
panel switches from the default waveform view to aspectral 
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display of the audio track, which makes it easier to remove 
specific frequencies from the sound. You can reopen the 
waveform view by clicking and dragging the split bardownward. 

 
 

Figure 6: The Remove A Sound task opens the spectral display in 
the Editor panel. 

 
The Effects panel is the next panel in the group. When you add 
effects, you are essentially creating a set of effects that are listed 
in this panel. 

 
The Markers panel allows you to add markers (known in Adobe 
Flash as cue points) at any point in your sound file. This is 
particularly useful when you are exporting to Flash Video, because 
this panel lets you embed event and navigation markers that can 
be read in Flash. 

 
Figure 7: The Markers panel 
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Below the Tasks, Effects, and Markers panel group is the History 
panel. The History panel is similar to the History panels found in 
other Adobe applications. It contains a list of all of the actions 
performed since the file was opened. Click on an action to return 
the file to that state. Press Delete to delete a selected action. 

 

 
Figure 8: The History panel 

 
The main panel in the workspace is called the Editor panel. You 
can switch between any of the sound files you have opened by 
choosing the file from the pop-up menu in the upper-left corner of 
the panel. The zoom navigator, is located directly below the pop- 
up menu and provides a view of the entire waveform. You can use 
the main Editor window to zoom in on just a range of the 
waveform in greater detail. To zoom in or out, press the + (plus) 
or – (minus) keys. To return to 100% view, click the Zoom OutFull 
button to the right of the zoomnavigator. 

 
 

Figure 9: Zoom in on a portion of the audio track using the + and – 
keys 
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Click and drag over a portion of the waveform. Notice that a menu 
pops up allowing you to increase or decrease the volume of the 
range. Click and drag the underlined number to the right or left to 
increase or decrease this setting. Click anywhere in the Editor 
panel to deselect the range. 

 
 

Figure 10: Increase or decrease the amplitude of a range by using 
the volume pop-up menu. 

 
The Set Fade In <<icon> and Set Fade Out buttons in the upper  
left and right corners of the Editor window allow you to set up 
fades at the beginning and end of the audio clip. Click and drag 
the Fade In Point to the right to set up a fade in the beginning of 
the audiotrack. 

 
Trim handles are located on either side of the Editor window. 
Click and drag the right trim handle to the left to create a new 
end point for the audiotrack. 
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Figure 11: Drag the trim handles to edit the beginning or end of an 

audio track. 
 

At the bottom of the Editor panel is a numeric Time slider, 
Previous and Next Marker buttons , Stop and Play buttons , Loop 
Playback , Record Open Dialog , Fade In and Fade Out buttons, a 
volume adjustment feature for the entire track , and a Louder 
button to make certain parts of the audio louder. 

 
Try experimenting with some of these controls. When you are 
finished, you may have a better idea about how to customize the 
Soundbooth workspace to best accommodate your own particular 
workflow. 

 
 
 

 
Figure 12: The Editor panel controls 
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Visit an animation or sound studio and study the procedures adopted for sound recording and editing. 
Also study the various equipment and accessories and the software available with the studio. 

 

Assessment  
 

Fill in the blanks 
 

1. In Adobe Sound Booth, the upper-left corner of the default workspacecontains the  

panel. 

2. The Tools panel contains the most frequently used toolsin booth, the Time 

Selection tool, the Frequency Selection tool, the Marquee tool, the Lasso tool, the Hand tool and 

the Zoomtool 

3. In the upper-right corner of the interfaceisa pop-up menu. 

4. The panel allows you to add markers (known in Adobe Flash as cue 

points) at any point in your soundfile. 

Checklist for AssessmentActivity  
 
 

Use the following checklist to see if you have met all the requirements for assessment activity. 
 
Part A 

 
Differentiated between the following: 

 
Different panels of Adobe Sound Booth. 

 

Part B 
 

Discussed in class the following: 
 

Features and advantages of Adobe Sound Booth. 
 

Part C 
 

Performance Standards 
 

The performance standard may include, but not limited to: 
 

Performance Standards Yes No 
Edited a sound track using Adobe Sound Booth   

Tabulated a chart depicting functions of different panels of Adobe Sound Booth   

Exercise 
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 Session 4: EditingSound  

In this session you will learn about how to increase or decrease the length of the range by clicking and 
dragging the start and end points of the audio track. You will also learn how to edit the sound track. 

RelevantKnowledge  EditingAudio 

Choose File > Open and open Interview.wav. This sound file is an 
excerpt from an interview. You can see the waveform of the file 
in the Editorpanel. 

 
 
 
 
 
 
 
 
 
 

Figure 1: The waveform of the audio clip is visible in the Editor panel. 

Click the Play button <<icon>> at the bottom of the Editor panel 
to play thefile. 

 
This audio clip has some problems, namely the cell phone ringing 
near the beginning. These issues are covered in the tutorial on 
screening and restoring audio. For now, you‘ll focus on some of 
Soundbooth‘s more basic editing capabilities. 

 
The first important skill to learn is how to select a specific portion 
or range of the waveform. To select a range, choose the Time 
Selection tool <<icon>> in the toolbar and then click and drag 
across the waveform in the Editor panel with your mouse. Any 
changes you make are applied only to the selected range. 
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Figure 2: Select a range of the waveform using the Time Selection tool. 

Select a range and click the Play button <<icon>>. Notice that the 
clip starts to play from the beginning of the range. 

 
You can modify the selected range by dragging the start and end 
points in the time ruler of the Editor panel. Move them closer 
together to shorten the range or farther apart to lengthen the 
range. 

 
 
 
 
 
 
 
 
 
 

Figure 3: Increase or decrease the length of the range by clicking and dragging the start and end 
points in the time ruler. 
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Click the Loop Playback button <<icon>> at the bottom of the 
Editor panel to hear the selected range repeat when you click the 
Play button. 

 
 
 
 

Figure 4: Click the Loop Playback button to loop a 
selected range when you press Play 

If you have trouble making a very precise range selection, you can 
zoom in on the waveform. To zoom in or out, press the + (plus) or 
– (minus) keys on your keyboard or use the Zoom tool <<icon>> in 
the Tools panel. The Zoom tool works similarly to the Zoom tool in 
Adobe Photoshop CS3. You click and drag on the area you want to 
zoom in on or click the mouse to zoom in on an area. Hold down 
Alt (Windows) or Option (Mac OS) and click to zoom back out. If 
you have a mouse with a scroll wheel, scroll forward to zoom in 
and scroll backwards to zoomout 

 
The zoom navigator is located at the top of the Editor panel. You 
can see your entire waveform, navigate through the time line, and 
zoom in and out on different parts of the waveform. 

 
To navigate to a different area of the waveform, hover your 
mouse over the highlighted area in the zoom navigator until it 
switches to the Hand tool and then drag to the left or right. The 
new highlighted area appears in the mainwindow. 

 

 
 

Figure 5: Hover over the highlighted area in the zoom navigator 
until the cursor switches to the Hand tool and drag to the right or 
the left to move to a different point in time. 

 
Click and drag the edges of the range in the zoom navigator in or 
out to zoom in or out on the waveform displayed in the main 
window. 
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Figure 6: Move the end points in the zoom navigator to zoom in or 
out on the clip displayed in the main window. 

 
To view the entire waveform in the main window, click the Zoom 
Full button <<icon>> to the right of the zoom navigator. 

After you select a range, the workflow is similar to having text 
selected in a word processing program, that is, you can edit, cut, 
copy, paste it, and so on. To access these options, press Control 
and right-click on the selected range, use the standard keyboard 
commands (for instance, Control+X to cut), or use the Edit menu. 

To delete a selected range, press the Delete key on your 
keyboard. Select 00:00:01.20 through 1.50 (this is the word drink 
when the interviewee says ―energy drink company�) and press 
Delete. Press Play to review youredit. 

Press Control+Z (Windows) or Command+Z (Mac OS) to undo the 
deletion. 

Select 00:00:07.25 to 8.75, where the waveform looks a little 
shorter. Press Play to hear the interviewee say ―When I first saw 
her arrive, I was….�. This section of the waveform is  shortbecause 
it is quieter than the rest of theclip. 

 
 
 
 
 
 
 
 

Figure 7: Select the range from 00:00:07.250 to 08.750 
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To make the selection louder, go to the Volume pop-up bubble  
and change the underlined number to increase the value and the 
volume or amplitude of the selected range (to about +2.6 dB). 
Notice that while you are dragging your mouse, a ghost image of 
the modified waveform appears in the window, showing you how 
the range will compare to the surroundingaudio. 

 
Note: Volume changes are measured and made comparatively, so 
the decibel value returns to 0.0 when you release your mouse, so 
that you can make further adjustments. 

 
 
 
 
 
 
 
 
 
 

Figure 8: Drag the underlined numbers in the Volume pop-up bubble to change the volume of the 
selected range 

Click the Play button to hear the difference the change made to 
the selected range. 

 
You may have noticed that the same volume icon is located at the 
lower-right corner of the Editor panel. 

 
You can use it to adjust the volume of range, as you just did, or to 
adjust the overall volume of the sound file. 

 
If you are attempting to make the entire clip louder, consider 
using the Louder button <<icon>> just to the right of the volume. 
The first time you click it, Soundbooth normalizes the entire file, 
meaning that the entire clip is equally amplified. With each 
subsequent click, the Louder button adds 3 dB to the clip, but also 
uses a hard limiter, which amplifies the quieter parts of the clip 
more than the louder parts. This helps to ensure that you donot 
end up distorting your audio clip. 
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Click the Louder button once to make the entire Interview.wav 
clip louder and then click it again to amplify the quiet sections of 
the file. Notice that the Applying Hard Limit dialog box flashes on 
the screen. If you are familiar with other audio editing programs, 
where you have to change multiple filters and settings to achieve 
the same results, the Louder button will seem like a real time 
saver. 

 
 
 
 
 
 
 

Figure 9: Clicking the Louder button adds 3dB to the overall volume of the clip while applying a hard 
limit to keep the sound normalized. 

Press Control+Z (Windows) or Command+Z (Mac OS) twice to 
return the clip to its normalvolume. 

 
Another editing feature in Soundbooth is the ability to add fades 
to the beginning and end of audio clips using visual markers. To do 
so, make sure the beginning of the waveform is in focus in the 
main window of the Editor panel. Notice the black box located in 
the upper left corner of the window. This box is in the Fade In 
handle. Click and drag the handle to the right to add a fade. 
Continue dragging to lengthen the fade. Notice that as you drag, 
the portion of the waveform affected in the fade immediately 
shortens to reflect the decrease involume 

 
 
 
 
 
 
 
 

Figure 10: Drag the Fade In handle to the right to create a fade at the beginning of the clip. 
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Drag the Fade In handle down to change the curve of the fade 
line. This allows you to keep the overall length of the fade, but 
the sound builds more drastically. Drag the Fade In handles up to 
make the fade moregradual. 

 
The Fade Out handle at the opposite end of the waveform works 
in exactly the samemanner 

 
 
 
 
 
 
 
 
 

 
Figure 11: Drag the Fade In point up to produce a more dramatic fade 

 
To remove a fade, drag the Fade In Or Out handle back to the 
beginning or end of the waveform. 

 
In addition to fading the beginning and end of your sound files, 
you can also trim them using the trim handles found in the center 
of either side of the main window. Drag the trim handle at the 
end of the audio clip to the left to remove the last few seconds or 
even minutes from the clip. Drag the trim handle at thebeginning 
of a clip to the right to trim the beginning of a clip 
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Figure 12: Drag the trim handles inward to trim the beginning and end of clips 
 
Save Your Work 

 
Saving your work in Sound Booth All project-oriented editing programs such as Sound Booth are taxing 
to a computer. This means Sound Booth can crash without warning and you can lose all of your work. 

‖Goto―File and ‖Choose―SaveAs. Inthe―SaveAs�field,giveyourprojectarelevantname.Then,inthe 
‖―Devices  area, choose your thumb drive. Navigate to and select your project folder. Your 

‖Soundboothprojectfilewillbesavedasan.asnd(―AdobeSoundDocument )tothisfolder.Click 
‖―Save.  

 
 

Exercise  
 

Start Adobe Sound Booth. Open a file and edit using various commands. Note your observations and the 
problems that you faced while editing the file. 

Assessment  
 

Fill in the blanks 
 

1. While editing audio in Sound Booth, you can see the waveform of the file inthe 

 panel. 

2. To view the  entire waveform in the main window, clickthe Full button <<icon>> to 

the right of the zoomnavigator. 

3. After you select a range, the workflow is similar to having text selected in a word processing 
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program,thatis,youcanedit,cut,copy,pasteit,andsoon.Toaccesstheseoptions,press 



144  

 and right-click on the selected range, use the standard keyboard commands or use 

the  menu. 
 

Checklist for AssessmentActivity  
 

Use the following checklist to see if you have met all the requirements for assessment activity. 
 
Part A 

 
Differentiated between the following: 

 
1. Fade in and fadeout 
2. Zoom in and zoomout 

 
Part B 

 
Discussed in class the following: 

 
1. How to add fades to the beginning and end of audio clips using visualmarkers? 
2. How to zoom in and out on different parts of thewaveform? 
3. How to select a specific portion or range of thewaveform? 

 
Part C 

 
Performance Standards 

 
The performance standards may include, but not limited to: 

 
Performance Standards Yes No 
Edited a video using different editing commands in Adobe Sound Booth   

Demonstrated the knowledge of fade in and fade out in Adobe Sound Booth   
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Checklist for AssessmentActivity  
Use the following checklist to see if you have met all the requirements for assessment activity. 

 

Part A 
 

Differentiated between the following: 
 

1. Title safe zone and action safezone 
2. Crosshair tool and the Zoomtool 

 
Part B 

 
Discussed in the class the following: 

 
1. Current timeIndicator 
2. Safe zone, Grids, Guides andRulers 

 
Part C 

 
Performance Standards 
The performance standards may include, but not limited to: 
Performance Standards Yes No 
Demonstrated the knowledge of Current time Indicator   

Demonstrated the knowledge of Grids, Guides and Rulers   

Demonstrated the knowledge of time selection tool, the frequency selection 
tool, the marquee tool, the lasso tool, the hand final output 

  



146  

Glossary  
 

Activewindow The window in front of all other open windows, on a graphical user 
interface. For example, the Internet browser window you are using to 
read this web page is considered the activewindow. 

Animation A medium that creates the illusion of movement through the 
projection of a series of still images or ‗frames‘. The term is also used 
to refer to the techniques used in the production of an animated film - 
in 3D animation, primarily those controlling the motion of the objects 
and cameras within ascene. 

 
Animatic A rough animation that is used by animators to give some idea about 

the timing of a sequence, used as a kind of animatedstoryboard. 
 

Analog Analog video and audio emit a steady wave of magnetic patterns that 
are interpreted as video and audio to be transferred to magnetic tape 
forviewing. 

 
Action The scene description, character movement, and sounds as described 

in ascreenplay. 

AngleofView This is calculated by the focal length of the lens and the size of the 
image sensor. The 35mm equivalents differ according to the sensor 
size. 

 
Antagonist A character in a story or poem who deceives, frustrates, or works 

against the main character, or protagonist, in some way. The 
antagonist doesn‘t necessarily have to be a person. It could be death, 
the devil, an illness, or any challenge that prevents the main character 
from living ―happily everafter. 

 
AspectRatio The ration of horizontal to vertical dimensions of an image. For 

example, 35mm slide film = 3:2, TV = 4:3, HDTV = 16:9, 4x5 Film =5:4 
 

AutomaticExposure The camera sets the shutter speed and aperture for the correct 
exposure according to thelight. 

 
AutomaticFocus The lens on the camera focuses automatically when the shutter is half 

pressed. The viewfinder normally has focussing points shown to assist 
the user in knowing what will be infocus 

Bitmap The method of storing information that actually maps an image pixel 
bit by bit. Formats include; .bmp, .pcx, .pict, .tif, .tiff, .gif. Most 
picture files are bitmapped 

 
BitDepth The number of bits used to define the shade or colour of each pixel in 

animage,a‗bit‘beingthesmallestunitofmemoryorstorageona
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computer. (One ‗byte‘ is eight ‗bits‘.) A 1-bit image is black and 
white. An 8-bit image provides a 256-colour palette. A 24-bit image 
provides 16.7 million possible colours, a palette sometimes knownas 
‗True Colour‘. A 32-bit image provides the same palette, plus an 8-bit 
grayscale alpha channel. 

CD-ROM It stands for Compact Disk Read OnlyMemory 
 

Consumables Items that need to be replaced such as toners, ink cartridges, paper, 
blank disksetc. 

CPU (Central Processing Unit) A chip or chips on the main board containing the control unit and the 
arithmetic/logic unit that interprets and carries out the basic 
instructions that operate acomputer. 

 
Compression A technique for reducing the quantity of data required to make up a 

digital image. Compression techniques can be non-destructive 
(‗lossless‘) or destructive (‗lossy‘), in which part of the data set is 
discarded permanently. Converting still images into JPEG format is one 
example of lossycompression. 

 
CloseUps For people this usually means the shot frames just the head.  

 
Domain The name of a particular Internetsite. 

 
Diskdrive The device that operates (reads and writes) to the floppy disk, HDD, 

DVD andCD-ROM. 

Driver Operating systems and applications use a general system call to 
operate hardware devices. The driver is a software routine that 
translates it into the specific instructions needed to control the 
hardwaredevice. 

 
DVD (Digital Versatile Disc) 120mm optical disc with a capacity of 4.7 gigabytes. 

 
DigitalVideo(DV) A format for storing digital audio and video used by DV standard digital 

videocameras. 
Dialog Very simply, this is what people are supposed to say according to the 

script. 
 

DigitalFilm Quite simply a Solid state flash memory cards in place of emulsionfilm 
 

Dolly A small platform on wheels used for holding heavy objects, typically 
film or television cameras. A mechanism on which a camera can be 
moved around a scene orlocation 

ExtremeClose They are much tighter close up shots in which you get detail greater 
than the human eye might be able to normally perceive. An example 
of this shot might be of the mouth and eyestogether 

 
ExtremeWideShots They are act to establish thearea. 

 
Health and safety legislation Service providers have obligations to ensure that reasonable steps 

have been taken to ensure the health and safety of customers. Health 
and Safety legislation provides for different responsibilities according 
to the products or services that the organisation isoffering. 
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Hardware The physical components of the computer system e.g., Keyboard, 
mouse, speakersetc. 

MediumShots This is the most common shot and allows for hand gestures and 
motion. 

Medium Close Up shots    It shows the subject in more detail and are often framed from just   
below the shoulders to the top of thehead. 

 
Operatingsystem An operating system or OS is a software programme that enables the 

computer hardware to communicate and operate with the 
computersoftware. 

 
Rhythm It is the sequence that is repeated in a period oftime. 

 
RGB Color represented as red, green and blue components. Most computer 

monitors use RGB pixels to display animage. 
 

Scene An event that takes place entirely in one location ortime. 
 

Secondary storage Hardware device used to record and retrieve data and instructions e.g. 
floppy disk, tape,CD-ROM 

Storyboard A storyboard is a view of the workspace, showing thumbnails of the 
clips in a video editing program. Storyboards also refer to sketches or 
descriptions of scenes to be shot in a movie before production gets 
underway. 

Timeline A view of the workspace that focuses on the timing of yourclips. 
Tracks Timelines are divided into horizontal sections known as tracks. Clips 

are arranged in various tracks to adjust their timing relative to one 
another. 

 
Wide Shots It shows the entire person or area. They‘re great for establishing the 

scene and allow for good action of the characters. Sometimes this is 
known as the longshot. 

Zoom The lens on a camcorder ranges from wide angle through to telephoto. 
Currently camcorders come with anything from a 10x to a 22x optical 
zoom. All camcorders also have a digital zoom which magnifiespixels. 

 
 
 

Suggested Reading  
 
 

Books 
 

1. Autodesk Maya UserGuide. 
2. DreamWorks Animation- ProductionProcess 
3. Adobe Sound BoothHelp 
4. Adobe Premiere ProHelp 
5. Adobe Soundbooth CS3: Classroom in aBook 
6. Adobe Premiere Pro CS3 Classroom in aBook 
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 Preface  
 

The National Curriculum Framework, 2005, recommends that children’s life at school must be linked 
totheirlifeoutsidetheschool.Thisprinciplemakesadeparturefromthelegacyofbookishlearning which 
continues to shape our system and causes a gap between the school, home, community, and 
theworkplace. 

 
The student workbook is a part of the qualification package developed for the implementation of 
National Vocational Education Qualification Framework (NVEQF), an initiative of Ministry of Human 
Resource Development (MHRD), Government of India to set common principles and guidelines for a 
nationally recognized qualification system covering Schools, Vocational Education and Training 
Institutions,TechnicalEducationInstitutions,CollegesandUniversities.TheNVEQFwassubsumedin 
National Skills Qualifications Framework (NSQF) in 2013. It is envisaged that the NSQF will promote 
transparency of qualifications, cross-sectoral learning, and student-centred learning and facilitate 
learner’s mobility between different qualifications, thus encouraging lifelonglearning. 

 
Thisstudentworkbook,whichformsapartofvocationalqualificationpackageforstudentswhohave passed 
Class X or equivalent examination, was created by a group of experts. The Media and Entertainment 
Sector Skill Council developed the National Occupational Standards (NOS) and the 
QualificationPack(QP)forthejobrole.TheNationalOccupationalStandardsareasetofcompetency 
standards and guidelines endorsed by the representatives of Industry for recognizing and assessing 
skills and knowledge needed to perform effectively in theworkplace. 

 
The Pandit Sunderlal Sharma Central Institute of Vocational Education (PSSCIVE), a constituent of 
NationalCouncilofEducationalResearchandTraining(NCERT)hasdevelopedmodularcurriculaand 
learningmaterials(Units)forthevocationalqualificationpackageinMediaandEntertainmentsector for 
Class XI. Based on NOS, occupation related core competencies (knowledge, skills, and abilities) 
were identified for development of curricula and learning modules(Units). 

 
This student workbook attempts to discourage rote learning and to bring about necessary flexibility 
in offering of courses, necessary for breaking the sharp boundaries between different subject areas. 
The workbook attempts to enhance these endeavours by giving higher priority and space to 
opportunities for contemplation and wondering, discussion in small groups and activities requiring 
hands-on-experience.Wehopethesemeasureswilltakeussignificantlyfurtherinthedirectionofa child- 
centred system of education outlined in the National Policy of Education(1986). 

 
The success of this effort depends on the steps that school Principals and Teachers will take to 
encouragechildrentoreflecttheirownlearningandtopursueimaginativeandon-the-jobactivitiesand 
questions. Participation of learners in skill development exercises and inculcation of values and 
creativity is possible if we involve children as participants in learning, and not as receiver of 
information. These aims imply considerable change in school routines and mode of functioning. 
Flexibility in the daily time-table would be a necessity to maintain the rigor in implementing the 
activitiesandtherequirednumberofteachingdayswillhavetobe increasedforteachingandtraining. 
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 About YourWorkbook  
 

Thestudentworkbookcontainssessionswhichwillhelpyoutoacquirerelevantknowledgeandskills 
(genericanddomain-specificskills)relatedtothejobrole.Eachsessionissmallenoughtobeeasily tackled 
and digested by you before you move on to the next session. Animated pictures and photographs 
have been included to bring about visual appeal and to make the text lively and 
interactiveforyou.Youcanalsotrytocreateyourownillustrationsusingyourimaginationortaking the help 
of yourteacher. 

 
Let us now see what the sections in the sessions have for you. 

 
Section1: Introduction 

 
This section introduces you to the topic of the Unit. It also tells you what you will learn through the 
various sessions covered in the Unit. 

 
Section 2: Relevant Knowledge 

 
This section provides you with the relevant information on the topic(s) covered in the session. The 
knowledge developed through this section will enable you to perform certain activities. You should 
readthroughtheinformationtodevelopanunderstandingonthevariousaspectsofthetopicbefore you 
complete theexercise(s). 

 
Section 3: Exercise 

 
Eachsessionhasexercises,whichyoushouldcompleteontime.Youwillperformtheactivitiesinthe 
classroom, at home or at the workplace. The activities included in this section will help you to 
develop necessary knowledge, skills and attitude that you need for becoming competent in 
performing the tasks at workplace. The activities should be done under the supervision of your 
teacher or trainer who will guide you in completing the tasks and also provide feedback to you for 
improving your performance. 

 
Section 4: Assessment 

 
The review questions included in this section will help you to check your progress. You must be able 
to answer all the questions before you proceed to the next session



5 | P a g e 

 

44 | P a g e 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

SECTOR: MEDIA AND ENTERTAINMENT 
 
 
 

Module 1: Animation: 
Windows and Editor 

 
 
 

Student Workbook 
(Class XII) 



 

 

 

Table of Contents 
 

INTRODUCTION 
 

SESSION 1: DOPE SHEET 
 

SESSION 2: ANIMATION CONTROL AND INTERFACE 
 

SESSION 3: NONLINEAR ANIMATION 
 

SESSION 4: ANIMATION LAYER EDITOR 
 

 
 
 
 
 
 
 
  
  
 
 
 
 
 
 
  
 



 

Introduction  

 
 

Maya animation provides you with the powerful tools you need to 
bring the characters and objects in your scenes to life. These tools 
give you the freedom to animate any attribute of an object and the 
control you need to successfully transform joints and bones, IK 
handles, and models over time. 

 
Graph editor, trax editor and dope sheet, these are the main 
animation editors in Maya. The Dope Sheet is another animation 
editor in Maya that is similar to the Graph Editor. Instead of 
displaying curves, the Dope Sheet displays key times as coloured 
rectanglesandletsyouediteventtiminginblocksofkeyframesand 
synchronize motion to a soundfile. 

 
Traxeditormainlyhelpstheanimatortodononlinearanimation.You can 
import and export animation clips using traxeditor. 

 
In this unit, you will learn about the animation windows and editor. 

 
 

 
 
 
 
 
 
 

 



 

Session 1: DopeSheet 

 
In this session, you will learn about the pre- and post-infinity animation curves options change rotation 
intern and dope sheet. 

RelevantKnowledge  
The Dope Sheet 

 
The Dope Sheet is another animation editor in Maya that is similar 
to the Graph Editor. Instead of displaying curves, the Dope Sheet 
displays key times as coloured rectangles and lets you edit event 
timing in blocks of keyframes and synchronize motion to a sound 
file. 

 
Inthemainmenubar:Window>AnimationEditors>DopeSheet In 
scene view: Panels > Panel > Dope Sheet (in Graph Editor 
window) 

 

 

Dope Sheet menu bar 

Edit menu 

Many of these menu items appear and behave in a similar fashion 
to the main Edit menu in the scene view. However, as the Dope 
Sheet works directly with animation curves and attributes, there 
are no hierarchy options available within the settings windows for 
the edit functions. 
 
Note: The Dope Sheet, the Edit > Keys menu selection, and Time 
Sliderallshareacommonkeysclipboard.Keyscopiedorcuttothe 
clipboard using one tool are available to the othertools. 

 
 
 
 



 

Undo/Redo 
Undo cancels the last operation. Redo does the last undone 
operation again. 

 
Cut:Cutremovesexistingkeysfromaselectedattributeandplaces 
acopyofthatinformationonthekeysclipboard.Ifacurvesegment is 
selected in the graph view, this area will be removed when you 
chooseEdit>Cut.Ifnocurvesegmentisselected,Cutwilloperate on the 
item selected in the Outliner portion of the DopeSheet. 

 
Copy: Copy copies existing keys from a selected attribute and 
placesthatinformationonthekeysclipboard.Ifyouselectacurve 
segment in the graph view, this area will be removed when you 
choose Edit > Copy. If no curve segment is selected, Copy will 
operate on the item selected in the Outliner portion of the Dope 
Sheet. 

 
Paste: Paste adds keys from the keys clipboard to an attribute. 
Pasted keys can be merged with existing keys, inserted at a time 
(displacing existing keys), or used to replace keys at a time. 

 
Delete: Delete removes existing keys from a selected attribute. It 
works the same as Cut except it does not place a copy of the 
removed keys on the keys clipboard. 

 
Scale: Scale operates on a selected range of keys, expanding or 
compressingtheanimationtocorrespondtoanewtimerange.Note 
thatScalewilloperateontheentirerangeofkeysifanattributeis 
selected in the Dope Sheet outliner and a curve segment is not 
selected. 

 
Snap:UseSnaptoforceselectedkeystosnapintimetothenearest whole 
time units. Use Select Unsnapped to check for keys not at whole 
timeunits. 

 
Select Unsnapped: Selects all keys from the selected channel. If 
noobjectsorattributesareselected,itselectsanykeysintheView Area. 

 
View menu: This menu controls the layout of the Dope Sheet view 
area. 

 
Note: When framing the desired range, the Dope Sheet may scale 
theareawithinthegraphviewhorizontallyandverticallytodisplay the 
desiredrange. 

 
Frame All: Frame All adjusts the graph view to fit all animation in 
the window. 

 
Frame Selection: Adjusts the graph view to fit selected animation 
in the window. 



 

Frame Playback Range: Frame Playback Range adjusts the graph 
view to fit the playback range in the window. 

 
Centre Current Time: If you want to shift the view so the current 
timeisinthemiddleoftheeditor,selectCentreCurrentTimefrom the 
Viewmenu. 

 
Auto Frame: This adjusts the graph view to fit the display when 
new curves associated with a selected object are loaded into the 
Dope Sheet. 

 
Note: Auto Frame works differently in the Dope Sheet than in the 
Graph Editor. 

 
Dope Sheet Summary: This option loads the Dope Sheet Summary 
into the Dope Sheet outliner. 

 
Scene Summary: This option loads the Scene Summary into the 
Dope Sheet outliner. 

 
Curves menu: The Curves menu items are functions for processing 
animation curves. 

 
Pre and Post Infinity animation curves options 

 
In Maya, animation curves are extrapolated outside the first and 
lastkeysofthecurve.Curvesbeforethefirstkeyandafterthelast key 
will be flat (no change in value over time) unless you set the 
preandposttangentcontrolstoanythingotherthanconstant.You can 
use these options to automatically generate specific types of 
repeatinganimation. 

 
Note: If you want to create editable animation of a repetitious or 
cyclical nature, you can bake a channel with Infinity turned on. 

 
BakeChannel:Thisoperationcalculatesanewanimationcurvefor 
anattributeusingtheinputnodesthatcontributetoitsproperties. 

 
Bake Channel is useful to: 

 
• Editasingleanimationcurveinsteadofallthecontributing 

attributes that affect the behaviour of a single attribute, 
for example, an object affected by a driven key or an 
Expression. 

• Add keys to an existingcurve 
 

Change Rotation Interp 
 

Let’schangetherotationinterpolationtypeofexistingcurves.You can 
change the rotation interpolation type only on rotation 
channelsthathavekeyframesonallthreechannels(rotateX, 



 

rotate Y, rotate Z). In addition, because the rotate X, rotate Y and 
rotate Z channels always share the same interpolation type, 
changing interpolation for a single channel such as rotate X, will 
automatically change rotate Y and rotate Z as well. 

 
Simplify Curve 

 
Use this operation to remove keys that are not necessary to 
describe the shape of an animation curve. Excess keys may 
accumulate on an animation curve as a result of adding keys 
manuallyorperformingoperationssuchasaBakeChannel.Youmay 
need to remove keys from an animation curve to reduce the 
complexityofthegraphview.Youmightalsoneedtoprovidelarger 
spans for adjusting curvetangents. 

 
Resampling curves 

 
You can resample dense data curves with the Curve > Resample 
Curves option in the Graph Editor or Dope Sheet. Resampling 
creates a periodic frame rate by placing keys at uniform intervals. 

 
To resample a curve, you select a sampling filter, which is an 
algorithm defining how the keys in the curve are resampled. 
Tangentandcurvevaluesareignored.Thefilterconvertsanimation 
curves with keys at either uniform or non-uniform intervals to 
curves with keys at a uniform interval that youspecify. 

 
Tip: The resampling filters are designed to reduce the number of 
keys in dense data curves. It may not produce the desired results 
when used on curves with few keys. 

 
Spreadsheet: This menu selection lets you edit the attributes of 
the selected animation curves in the Attribute Editor spreadsheet. 

 
Non-Weighted and Weighted Tangents 

 
Specifythetangentweightingforselectedkeys.Thedefaultsetting is 
non-weighted tangents, which provide simple handles for 
manipulating the tangent’sangle. 

 
Weightedtangentsrepresenttheamountofinfluenceatangenthas 
onananimationcurvesegment.ByturningonFreeTangentWeight, it is 
possible to simultaneously edit the influence and angle of the 
tangent quickly and intuitively. Users of desktop illustration 
packageswillrecognizethefamiliarBezier-stylebehaviourwhenin 
thismode. 

 
Keys menu 

 
 Convert to Key Converts selected breakdowns tokeys. 
 Convert to Breakdown Converts selected keys tobreakdowns. 
 Add in between Inserts an in between at the currenttime. 



 

 Remove in between Removes an in between at the current 
time. 

 
Mute Key 

 
Mutes the selected keys. Keys that are muted do not contribute to 
the animation on their channels. 

 
When keys are muted, the following occurs: 

 
A green symbol appears next to the names of the muted keys 
channels in the Dope Sheet Outliner. Mute channels with keys 
appear under the muted keys channels in the Dope Sheet. 

 

Mute channels have the same number of keys as the muted keys 
animationchannels,andtheirkeysarepositionedthesameasthose on 
the muted keys animationchannels. 

 
Unmute Key 

 
Unmutes the selected keys. Keys that are not muted contribute to 
theanimationontheirchannels.UnmutingkeysdisablestheirMute 
channels (indicated by the red x symbol next to the names of the 
muted keys channels in the Dope Sheet Outliner) but does not 
removethem. 

 
Tangents menu 

 
Tangentsdescribetheentryandexitofcurvesegmentsfromakey. 
Thismenuoperatesontheshapeofcurvesegmentsaroundselected 
keys.Notethatthesesettingsaffectonlyexistinganimationcurves 
segments’tangents. 

 
Spline 

 
Specifying a spline tangent creates an animation curve that is 
smoothbetweenthekeybeforeandthekeyaftertheselectedkey. The 
tangents of the curve are co-linear (both at the same angle). 
Thisensuresthattheanimationcurvesmoothlyentersandexitsthe key. 
When animating fluid movement, a spline tangent is an excellent 
place to start. You use a minimum number of keys to achieve 
yourlook. 

 
Linear 

 
Specifyingalineartangentcreatesananimationcurveasastraight line 
joining two keys. If the in tangent type is linear, the curve 
segmentbeforethekeyisastraightline.Iftheout-tangenttypeis linear, 
the curve segment after the key is a straight line. When 
animatingthecolourofaheatingelementonastove,youwould 



 

use linear to achieve that gradual change in colour from charcoal 
gray to burning hot red. 

 
Clamped 

 
Specifying a clamped tangent creates an animation curve that has 
the characteristics of linear and spline curves. 

 
The keys’ tangents will be splines unless the value of twoadjacent 
keys is very close. In this case, the out tangent of the first key and 
the in tangent of the second key will be interpolated aslinear. 

 
When animating a skeleton in a walk-cycle, you may notice a 
slipping of the pelvic and foot joint position. This occurs because 
the value of the keys on the curve are either the same or close to 
(withintoleranceof)thevalueoftheother.Mayaassignsadefault spline 
tangent to describe what occurs between these keys. This is why 
you get the joint positionsslipping. 

 
By setting the tangent type to clamped for these keys, theslipping 
iscorrectedandthetangentsbecomesacombinationoflinearand 
spline. 

 
In the Maya environment preferences, Clamped is the default 
tangent type. 

 
Stepped 

 
Specifyingasteppedtangentcreatesananimationcurvewhoseout 
tangent is a flatcurve. 

 
The curve segment is flat (horizontal), so the value changes at the 
key withoutgradation. 

 
The light from a strobe light turns on and off. To create a strobe- 
like effect, you would use a step tangent. 

 
Stepped Next 

 
FBIK animation keys use the stepped next tangent type by default. 
This tangent type differs from regular Stepped tangents in that its 
interpolation values jump immediately to that of the next key, 
rather than holding the value of the current key until the next key 
is reached. 

 
Flat 

 
Sets the in and out tangents of the key to be horizontal (with a 
slope of 0 degrees). When a ball reaches its ascent, it hangs in the 
air for a brief time before starting its descent. You can create this 
effect by using a flat tangent. 



 

Fixed 
 

Specifying a fixed tangent allows a key’s tangents to remain 
unchanged as the key is edited. 

 
When animating a ball, you may find the ball isn’t falling from a 
desired height, yet its impact with the floor and everything else is 
perfect.Usingafixedtangentletsyouchangetheheightoftheball while 
retaining the tangent’sangle. 

 
This process is useful when you want to: 

 
 Edit a single animation curve instead of all the contributing 

attributes that affect the behaviour of a single attribute, for 
example,anobjectaffectedbyadrivenkeyoranExpression. 

 Add keys to an existingcurve 
 

Plateau 
 

Plateau tangents ease animation curves in and out of their 
keyframeslikesplinetangents,butalsoflattencurvesegmentsthat 
occurbetweenequal-valuedkeyframeslikeclampedtangents.The 
plateautangentnormallybehaveslikeasplinetangent,butensures that 
the minimum and maximum values along a curve are all at 
keyframes. 

 
Plateau tangents are useful when you want the positions of your 
keyframes to be exact, because they ensure the maximum and 
minimumvalues(‘hillsandvalleys’)ofthecurvedonotextendpast 
theirkeyframes.Forexample,pictureananimationofaballrolling off a 
table, falling to the floor, and then rolling on the floor. With 
spline tangents, the ball falls through the floor, and then comes 
back up to the floor. With plateau tangents, the ball will not fall 
through the floor. The tangents guarantee that your animationwill 
not wander beyond the values youkeyframed. 

 
To do this, if a spline tangent would produce a minimum or 
maximumbetweentwokeyframes,theplateautangentflattensthe 
keyframes in question. Keyframes at local minimum and maximum 
points along the curve are also flattened. Finally, the first and last 
keyframe along a curve are always flattened if they have plateau 
tangents. 

 
In Tangent menu 

 
It lets you specify a type of tangent for the In Tangent only. TheIn 
Tangentdefinesthetypeofcurvesegmentthatcomesbeforeakey. 

 
NoteYou can also set the Default In Tangent for new keys in the 
Preferences window. 
Out Tangent menu 



 

 
 

Exercise  
 
 

1. Create a chain using basic polygonsprimitives. 
2. Animate the chain showing follow through using dopesheet 
3. Write a note on this exercise 

 

Assessment  
 

I. Answer the followingquestions 
 

1. What is dopesheet? 
 
 
 

 
 

 

2. Write a short description on dope sheet menubar. 
 
 

 

 

 

 
 

Checklist for AssessmentActivity  
 
 

Use the following checklist to see if you have met all the requirements for assessment activity: 
 

Part A 
 

Differentiated between the following: 
 

1. Simplify curves and resamplingcurves 
2. Pre and post infinity animationcurves 
3. Mute key and unmutekey 

 
 

Part B 
 

Discussed in the class the following: 
 

1. The dope sheet and itsuses 
2. Dope sheet menubar 

Let’sspecifyatypeoftangentfortheOutTangentonly.TheOut 
Tangentdefinesthetypeofcurvesegmentthatcomesafterakey. 



 

Part C 
 

Performance standards 
 

The performance standards may include, but not limited to: 
 

Performance Standards Yes No 

Demonstrated their ability to composite scenes using dope sheets.   

Demonstrated the knowledge of using dope sheet menu bar   

Demonstrated simple exercises on spread sheet   



 

Session 2: Animation Control andInterface  

 
Inthissession,youwilllearnabouttheanimationcontrol,timeslider,differenttermsusedinanimation and how 
to animate an object along asurface. 

RelevantKnowledge  An animation control is a window that displays an Audio-Video 
Interleaved (AVI) clip. An AVI clip is a series of bitmap frames like 
a movie. Animation controls can only display AVI clips that do not 
contain audio. 

 
Tool Bar 

 

 

 
Animation Control 

 
BetweentheRangesliderandtheAnimationPreferencesbuttonare the 
current character control features and the Auto Keybutton. 

 
 

 
 

Time Slider 
 

Click in the Time Slider area and drag left and right to "scrub" the 
animation back and forward in time. 



 

 

 
 

Range Slider 

You can toggle whether the Range Slider is Displayed or hidden by 
selecting Display>UI elements>Range Slider. 

 
Animation Start Time sets the start time of the animation. 

Animation End Time sets the end time of the animation. 

PlaybackStartTime This shows the current start time for the 
playback range. You can change it by entering a new starttime. 

 
Playback End Time: This shows the current end time for the 
playback range. You can change it by entering a new endframe. 

 
Range Slider Bar 

 
This lets you control the playback range of your animation up to 
the limits of the Animation start/end settings. 

 
You use the Preferences dialog box to change values for the 
animation timeline and playback. You can also set the total time 
for your animation, the size of the timeline , and other related 
features. 

 
Terms in Animation 

Frame Rate 

Frame rate is the first aspect of animation. By default, Maya sets 
your animation to Film, which plays at 24fps.You use 30fps in the 
United States and 25fps in other countries. 

 
Range 

 
The range of an animation determines the total length in frames. 
Then, multiply the animation's length in seconds by the frame rate 
.For e.g in this case you are using 24fps and animation length is of 
2seconds. 

 
24 fps X 2 secs = 48 Frames 



 

Setting Keys 
 

You can set a Key by selecting Animate >Set Key. The attributes set 
by this menu item depend on the set Key option settings. 

 
Animation Types 

 
There are following types to animate your scene. 

 
Path Animation 

 
Inthismethod,youcreateaNURBS-basedcurveandthenattachan 
objecttoitinyourscene.Theobjectthenfollowsthecurvedpath to 
simulate motion. You can choose at which time the object is 
positioned at any point along the path, so the object can reverse 
itself, pause, or oscillate, if you want. The object automatically 
rotates from side to side as the curve changes directions. If the 
objectisgeometry,itcanalsobeautomaticallydeformedtofollow the 
contours of thecurve. 

 
 

Make a chart containing various 2D animation processes with some examples. 
 

Assessment  
 

Answer the following questions 
 

1. What is TimeSlider? 
 
 

 

 

 

 

2. What is RangeSlider? 
 
 

 

 

 

 

3. Describe the terms Frame Rate 
 

 

 

 

 

Exercise 



 

Checklist for AssessmentActivity  
 

Use the following checklist to see if you have met all the requirements for assessment activity. 
 

Part A 
 

Differentiated between time sider and range sider 
 

Part B 
 

Discussed in class the following: 
 

1. The timeline andkeys 
2. What is timeslider? 
3. Animation control andinterface 
4. Nonlinearanimation 
5. Toolbar 

 
Part C 

 
Performance standards 

 
The performance standards may include, but not limited to: 

 
Performance Standards Yes No 
Demonstrate the knowledge and application of the time sider and range sider   



 

Session 3: Non-linearAnimation 

 
In this session, you will learn about the most advanced non-linear method of animation, graph editor 
component and trax editor. 

 
RelevantKnowledge  

 
 
 
 
 
 
 
 

 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Nonlinear Animation is a more advanced method of animation. 
Unlike keyframing, nonlinear animation is completely independent 
of time. You blend and layer animation sequences—called clips—to 
set up the motion for objects. You can also use this method to 
explore variations in parts of the animation without losing your 
previous work or affecting other parts of the animation. For 
example-youcanmakethewalkingpartoftheanimationaclipand then 
adjust the leg motion without affecting the way the rest of the 
charactermoves. 
 
Graph Editor 
 
The Graph Editor is a helpful tool for tweaking values for keys you 
have set. It gives you a visual representation—a curved line—of the 
attributesthatareanimated.Theanimationtimegoesfromleftto right, 
and any keyed variable appears as a line that ramps up or down to 
indicate its value over time. It can help you visualize how 
thingsarechangingandhowfast.Youcanpanandzoomthispanel like 
anyother. 
 
Touseitasafree-floatingwindow,simplyopenitfromtheHotbox 
(Window >Animation Editors> GraphEditor). 

Graph Editor's Components 

 
Menu Bar 
 
The Graph Editor menu bar contains tools and operations for 
manipulating animation curves and keys with in the graph view of 
theGrapheditor.TheEditmenuissimilartotheoneintexteditors 
orwordprocessors,exceptthatyou'reworkingwithkeysinsteadof text. 
 
The Edit Menu 
 
The menu’s items appear under Edit menu behave in a similar 
fashion to the main Edit menu in the modelling view. 

 
The View Menu 
 
This menu controls which components are visible, and therefore 
editable, in the graph view of the Graph Editor. 

 



 

 
 

 
 

Graphic Editor 

The Select Menu 
 
These options control which component of an animation curve is 
available for selection and editing. 
 
The Curves Menu 
 
The Curves menu gives you control over how the curves are set up 
with the keys in your scene. 
 
The Keys Menu 
 
This menu includes Tangents which causes the manipulation of an 
in or out tangent handle. 
 
The Tangents Menu 
 
This describes the entry and exit of curve segments from a key. 
 
The List Menu 
 
This menu Loads the objects. 
 
The Trax Editor 
 
The Trax Editor is a high-level animation tool that lets you select 
and control characters and their animation clips, layer and blend 
animation sequences, synchronize your animation and audio clips, 
and drag-and-drop animation clips between mapped characters. 
The trax editor is an inbuilt component in Maya similar to a video 
editing software like Adobe Premier or FinalCut There are many 
ways to get to the trax editor - In the Panels tab – Panels – Saved 
Layouts – Persp/Trax - Windows – Animation Editor – Trax Editor 
 
The Trax Editor window has four work areas: 
 
(i) Trax menu bar: Contains character and clip or object and 
geometry cache clip related options that let you perform all 
required actions for creating and editing your animation or 
deformationsnonlinearly. 
(ii) Trax toolbar: Contains a selection of buttons that let you 
quicklyaccesssomeofthefunctionalitycontainedintheTraxmenu bar. 
(iii) Track control area: Contains buttons that let you controlthe 
playback of each track’s animation or deformations. 
(iv) Track view area: Contains all the tracks, animation clips, 
geometrycacheclips,andaudioclipsforyourloadedcharactersor 
objects. 
 
Suppose you keyframed a character’s  walk and you  now want to 
turn it into a walk cycle. You can create a clip for the keyframe 
animationsequence,scaleandtrimthecliptogetittobetheright 
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1. Open trax editor and import some animationclips 
2. Edit the clips and manipulate them to get a requiredanimation. 

Assessment  
 

Answer the following questions 
 

1. What is traxeditor? 
 

 

 

 

 

 

2. Write a short description on visor and cliplibrary. 
 
 

 

 

 

 

Checklist for AssessmentActivity  
 

Use the following checklist to see if you have met all the requirements for assessment activity. 
 

Part A 
 

Differentiated between the various types of menus in Graph Editor. 
 

Part B 
 

Discussed in class the various windows of Trax Editor. 
 

Part C 
 

Performance standards 
 

The performance standards may include, but not limited to: 
 

Performance Standards Yes No 
Demonstrated the knowledge and application of nonlinear animation tools   

length and to have similar start and end poses, and then cycle the 
clip to create a proper walk cycle .If you wanted to change the 
walk cycle’s pace or rhythm, you can then create a time warp 
curve for the clip, or if you wanted to turn the walk into a march, 
you can 
manipulatethecharacterandkeyintotheclipdirectly.Youcando all 
this to the character’s walk sequence without destroying the 
original key frame animation because you are working withclips. Exercise 



 

Session 4: Animation LayerEditor  
 

In this session, you will learn about the Animation Layer Editor and Graphic Editor. 
 

RelevantKnowledge  The Animation Layer Editor lets you manipulate animation layers 
and change the way they blend together to create your result 
animation. It includes three main menus: 
(i) Layersmenu 
(ii) Optionsmenu 
(iii) Show menu 

 
 
 

 
The following table provides a  brief  overview  of  tasks  using  
the Animation LayerEditor. 

 
 

To... 
 

Do this 

Create ananimation 
layer for selected 
objects. 

 
Click . 

Create an empty 
animationlayer. Click . 

 
 

Change the 
animation layer 
mode. 

Right -click a layer and select Layer 
Mode, then 
select Additive, Override, 
or Pass through mode. 

Extract animation 
from selected 
objects in thescene 
onto alayer. 

 

Right  -click the Base Animation bar 
and select Extract Non-Layered 
Animation for SelectedObjects. 



 

 
 
 

Re-order layers in 
the stack. 

Selectthelayerand -dragittoanew 
position in the stack, or use the 

Move  Up andMovedown
buttons. 

 
 

Parent layers. 
Select the layer and -drag it ontothe 

layer you want as itsparent. 

Open 
theRelationship 
Editor to add and 
remove attributes 
to and fromlayers. 

 
 
 

Select Layers > Membership from the 
menu bar. 

 
 

Delete layers. 

Selectthelayersyouwanttodeleteand 
select Layers > Delete from the 
menubar. 

Set a Zero key. 
Click . 

Set and key the 
layer weight at 0. Click . 

Set and key the 
layer weight at 1. Click . 

 

Animation Layer toolbar 
 

 

The following table describes the buttons found in the Animation 
Layer Editor toolbar. 



 

 
 
 
 

 
 

 
 
 
 
 
 

Zero Key Layer 

 
Sets a key on the animation 
layer with zero offset from 
the original animation. This 
can help you demarcate a 
specific time range you 
want to edit on a layer. 

 

 
 
 

Set Weight to 0/Set Key 

Sets and key frames the 
animation layer Weight at 
zero. 

 

 
 
 

Set Weight to 1/Set Key 

 

Sets and keyframes the 
layer Weight at1. 

 

 
 
 

Move Layer Up 

Moves the selected layer(s) 
up in the Animation 
layer pane. 

 

Animation Layer Editor menu bar 
 

Layers menu 
The Layers menu contains the following items. 

 
Create Empty Layer 

Creates an empty animation layer. 
 

Create Layer from Selected 
Creates an animation layer that (by default) contains all of the 
selected object’s attributes. 

 
Create Override Layer 

Creates an empty animation layer set to Overridemode. 
 

Create Override Layer from Selected 
Creates a new animation layer that (by default) contains all of the 
selected object’s attributes, and sets the layer toOverridemode. 

 
Create Layer Options 

The Create Layer Options let you set which modes new layers will 
use. Select from the following options: 

 
Passthrough (Override Only) 

Sets new Override layers to Passthrough mode. 
 

Rotation Accumulation By Component 
Sets new layers to useBy Component Rotation 
Accumulationmode. 



 

Rotation Accumulation By Layer 
Sets new layers to use By Layer Rotation Accumulation mode. 

 
Scale Accumulation Multiply 
Sets new layers to use Scale Multiply Accumulation mode. 

 
Scale Accumulation Additive 
Sets new layers to Additive Scale Accumulation mode. 

 
Add Selected Objects 
Ads attribute of the selected object(s) to the selected animation 
layer(s). 

 
Add Selected Objects 

Opens the Add Objects To Animation Layers Options, letting you 
add groups of attributes to the layer. Select from the following 
options: 

 
All keyable 
Adds all of the selected object’s keyable attributes to the selected 
layer. 

 
From Channel Box 
It lets you add attributes selected in the Channel Box to the 
selected layer. When this option is selected, you can select 
attributes in the Channel Box and use Layers > Add Selected 
Objects to add them to the selected layer. 

 
All Keyable Except 

Lets you add all keyable attributes except attributes of a certain 
type. Use the list to select which attribute types to exclude: 

 
 Translate 
 Rotate 
 Scale 
 Dynamic 
 Boolean 
 Enum 

 
Remove Selected Objects 
Removes all attributes of the selected object(s) from the selected 
layer(s). 

 
Extract Selected Objects 

Extracts the selected object from the selected layer and places it 
on a new layer. The new layer is named after the selected layer, 
plus the suffix _extract. 

 
Select Objects 

Selects all objects in the scene that have attributes assigned to the 
selected layer(s). 



 

 

Copy Layer 
Creates a duplicate of the selected layer(s), containing all of the 
same attributes and animation. 

 
Copy Layer (No Animation) 

Creates a duplicate of the selected layer(s) containing all of the 
same attributes (and none of the animation). 

 
Merge Layers 

Merges the selected animation layers. 
 

Merge Layers 
Opens the Merge Layer Options. Select from the following options. 

 
Note 

Several of the Merge  Layer Options are the same  as  those in  
the Bake Simulation Optionswindow. 

 
Merge To 

Setwhichdirectionyouwantthemergetooccurinthestack.Select from 
the followingoptions: 

 
Top Selected Layer 

Merges the selected layers to the selected layer that is highest in 
the stack. (The highest layer in the stack is the ‘target’ layer, all 
other layers are ‘source’ layers.) 

 

 
Bottom Selected Layer 

Merges the selected layers to the selected layer that is lowest in 
thestack.(Thelowestlayeristhe‘target’layer;allotherselected layers 
are ‘source’layers.) 

 
Layers Hierarchy 

Sets whether child layers have to be selected to be included in the 
merge. Select from the following options: 

 
Selected 

Child layers must be selected to be merged. 
 

Include Children 
Child layers of any parent layer being merged are included, even if 
they are not selected individually. 



 

Graphic Editor 
 
 

 
 Supports many formats, including .ico, .gif, .avi, .cur,.ani. 
 Preview your animations in real time while editing sprites - No 

need to stop working to watch youranimation! 
 Usemultiplelayerstomakedrawingandeditingyourarteasier! 
 Onionskinningallowsyoutoseebothpreviousandnextframes while 

yourdraw! 
 Outputyouranimationframesontoasinglespritesheet,output 

eachframetoitsownimagefile,orexporttheentireanimation as a 
single .gif file. GraphicsGale's export options are flexible 
enough to be compatible with anyworkflow. 

 Createworkfromscratch,oruseGraphicsGale'sTWAINimaging 
support to import images from your scanner, camera, or other 
TWAIN-supporteddevices. 

 GraphicsGale also has many pixel-art specific features to help 
you create your work quickly and easily, including palette 
control, selectively erasing colours, and tools for quickly 
replacing and trying newcolours. 



 

Exercise  
 

Practise to understand the working procedure of animation layer editor. 
 

Assessment  
 

Answer the following questions 
 

1. What is layereditor? 
 

 

 

 

 

 

2. Explain the procedure of working with layereditor? 
 

 

 

 

 

 
 

Checklist for AssessmentActivity  
 

Use the following checklist to see if you have met all the requirements for assessment activity. 
 

Part A 
 

Differentiated between the various menus of the Animation Layer Editor. 
 

Part B 
 

Discussed in class the following: 
 

1. Layertoolbar 
2. Layer menubar 
3. Applications of animation layereditor 

 
 

Part C 
 

Performance standards 
 

The performance standards may include, but not limited to: 
 

Performance Standards Yes No 
Demonstrated the knowledge and application of animation layer editor   

Demonstrated the knowledge and application of animation clip editing   
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Introduction 
 

 
Inthisunit,wewilldiscussaboutthebasictoolsandtechniquesof 
animationinMaya.Thisunitwillteachyouthefundamentalsofthe way 
Mayaanimates. 

 
TimelineandkeysarethebasicneedforMayakeyframeanimation. Keys 
store a value at a given time in animation. This time is measured 
inframes. 

 
Mostanimationshave24framesinasecond,so,ifatframe1there's 
akeyframethatsaysthevalueis0,thenonframe24there'sakey frame 
with the value of5. 

 
Inthetime-spanofonesecond,thatvaluechangesfrom1to5.The way 
this value changes is defined bytangents. 

 
The bouncing ball includes many aspects of animation, such as the 
pathofaction,arcs,momentum,timing,keydrawings,in-between 
drawings, weight, speed, and the substance of an object are 
includedinthissimpleexercise.Wewilldiscussaboutgrapheditor and 
bouncing ball animation as the first animation inMaya. 

 
 
 

 
 
 
 
 

 
 
 
 
 
 

 



 

Session 1: Timeline andKey  

 
Inthissession,youwilllearnindetailsaboutMayaTimeline.Youwillalsolearnaboutthedisadvantage of Auto 
keys and how to change settings in MayaTimeline. 

 
   Relevant Knowledge  

Thetimelineiswherethebulkoftheanimationprocesstakesplace. This 
is where you control the speed at which a movie element moves, 
when it enters and exits the scene, and its depth, or 
stackingorder,inrelationtootherelementsinthescene.Hereyou are 
able to set animation keys, scrub through the animation, and 
change the range of time in your animation. Notice the four boxes 
thatcomprisetheRangeInfo.Thetwoouterboxes(withvalues 
1.00 and 48.00) are the start and end of your timeline. Think of 
these two numbers as representing the length of the whole 
timeline. The two inner boxes represent the start and end of the 
current section of the timeline. Many times, you will only want to 
edit keyframes on part of the timeline. 

 
Keys 

 
Keys store a value at a given time in animation. This time is 
measured in frames. Most animations have 24 frames in a second, 
so, if at frame 1 there's a key frame that says the value is 0, then 
on frame 24 there's a key frame with the value of 5. In the time- 
span of one second, that value changes from 1 to 5. The way this 
value changes is defined by tangents. 

 
Mayauses"keyframes"foranimation(wealsorefertotheminshort as 
"keys"). A key frame is basically a marker used to specify an 
object's position and attributes at a given point in time. To set a 
keyframe on the ball at the current frame, select the ball and go 
toAnimate→SetKey(orjusthits).Aredtickmarkshouldappear 
onthetimelineneartheslider,indicatingthatyouhave"keyed"the ball 
on the current frame. You may also notice that the attributes in 
the Channel Box have turned pink, an indication that the object 
has beenkeyed. 

 
AutoKey 

 
Autokey automatically saves the changes you make to an object's 
keyframes. If the current frame already has a key, autokey will 
immediatelyupdatethekeywithyourchanges.Ifthecurrentframe does 
not have a key, autokey will automatically create a keyframe 
basedonyouradjustments(thisonlyworksonobjectswithexisting 
keys).However,beawarethatwithautokeyitiseasytoaccidently 
create stray keys on the timeline or make changes you did not 
intend.Thoughitisrecommendedyoudonotuseautokeybefore 
fully  familiarizing  yourself  with the animation workflow, youcan 

 
 



 

enable it by clicking the icon below the playback settings. It 

will appear as once turned on. You should make sure not to 
have"AutoKey"onbecauseanytimeyoumoveorchangesomething; it 
will automatically key it for you, which can be very annoying if 
you are not trying to make an actualkey. 
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Figure1 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure2 



 

 
 
 
 
 
 
 
Exercise  

An important thing to before even starting to create your 
animations is to make sure your settings are correct in the options 
menu.Itisveryimportanttodecidethesesettingsbeforeyouwork 
ingroupstoavoidproblemswhentryingtomergeprojectstogether later 
on. We like to use 24fps for thiscourse. 

 
It is also good to generally keep the playback speed at "Real Time" 
so you can see what your motion will look like in the end. 

 

Animate the translate value of a sphere using timeline and keys. 
 

Assessment  
 

Answer the following questions 

What is key frame? 
 
 

 

 _ 
 

 
 

Checklist for AssessmentActivity  
 

Use the following checklist to see if you have met all the requirements for assessment activity. 
 

Part A 
 

Differentiated between key frame and auto key. 
 

Part B 
 

Discussed in class the following: 
 

1. How to copy akeyframe? 
2. Explain the importance of key line along with anexample 

 
Part C 

 
Performance standards 

 
The performance standard may include, but not limited to: 

 
Performance Standards Yes No 
Demonstrated the knowledge of keyframes and autokey in Autodesk Maya.   



 

Session 2: KeyFrames  

 
In this session, you will learn about the concepts of setting Key Frames and importance of S keys. 

 RelevantKnowledge  Whenyousetakeyframe(orkey),youassignavaluetoanobject’s 

attribute (for example, translate, rotate, scale, colour, and so on) 
at a specific time. 

 
Most animation systems use the frame as the basic unit of 
measurementbecauseeachframeisplayedbackinrapidsuccession to 
provide the illusion ofmotion. 

 
Whenyousetseveralkeysatdifferenttimeswithdifferentvalues, Maya 
generates the attribute values between those times as the 
sceneplaysbackeachframe.Theresultisthemovementorchange over 
time of those objects andattributes. 

 
In the following steps, you use key-frames to set the starting and 
ending positions of the ball’s movement. 

To set beginning and ending key frames 

 
Click the rewind button to go to the start of the playback range. 
This change the current frame to 1. 

 
Select the ball, then select Animate > Set Key. (Keyboard 
shortcut: s ). 

 
This sets a key at frame 1 for all transform attributes of the ball. 
Transform attributes are the X, Y, Z move attributes. Althoughyou 
animate only the translate X and Y attributes of the ball in this 
lesson, keying all transform attributes saves you time having to 
choose specific attributes to be keyed. In the Time Slider, notice 
theredmarkeratframe1,knownasatick.Thistickappearedwhen you 
set the key for frame 1. With the ball selected, ticks in the Time 
Slider indicate where you’ve setkeys. 

 
Go to frame 72. A convenient way to do this is to click thedesired 
position in the TimeSlider. 

 
With the Move Tool, drag the ball’s X-axis handle to position the 
ball at the right edge of the ground as shown in the image below. 
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Set a key at frame 72. (Press s.) 
 

1. Go to the start time and play theanimation. 
2. From the two keys you’ve set, Maya creates motion 

betweenthepositions.Bydefault,theanimationplaysina 
loopfromframe1to72.Theballtravelsthroughthefence at 
thisstage. 

3. Press the Stop button on the playback control to stop the 
animation after you view a fewrepetitions. 

4. You can drag the mouse back and forth (scrub) in the Time 
Slidertoseetheanimationplaybackandforthatthespeed you 
drag themouse. 

5. If you were to display the scene with Panels > Layouts > 
Four Panes, only the active panel would show the ball 
moving. 

6. Tomaketheballflyoverthefenceratherthanpassthrough it, 
you need to position the ball above the fence and set a 
keythere. 

 
To set intermediatekeyframes 

 
1. Go to frame 33 or so—at the moment where the ball sits in 

the middle of thefence. 
2. With the Move tool, drag the Y-axis handle of the balluntil 

it sits slightly above thefence. 
 

Tip: Throughout this lesson, tumble the perspective view or 
examine a front view to make sure the positioning is correct. 

http://download.autodesk.com/ 

 
1. Set a key. (Presss.) 
2. Play theanimation. 

The ball now flies off the ground, over the fence, and back to 
the ground in a smooth arc between the keyed start, middle, 
and end positions. 

 
Press the stop button to end theplayback. 

Insubsequentsteps,playtheanimationaftereachkeyyouset. It’s 
generally useful to check your work in progress after each 
key, especially when you arelearning. 
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In the next steps, you’ll set keys to bounce the ball in the 
middle of the right half of the ground. 

 
To set keyframes to make the ball bounce 

 
1. Go to frame 50. At this moment, the ball sits in a position 

above the middle section of the right half of theground. 
2. Move the ball so it sits on theground. 

 

http://download.autodesk.com/ 
 

1. Set akey. 
2. Go to frame60. 
3. Move the ball up again, but not as high as its peak height 

above thefence. 

http://download.autodesk.com/ 
 

4. Set a key. When you play the animation, the balltravels 
over the fence and bounces on the otherside. 

If you have a fast computer, you might notice that the animation 
playstoofast.Bydefault,Mayaplaystheanimationasfastasitcan be 
processed. Because this scene is simple, the animation might play 
faster than the default film rate (24 frames persecond). 

Donotbeconcernedthattheanimationplayswithahaltingorjerky 
motion.Whenyourenderalltheframesofyouranimationforfinal 
production, the animation will be smooth. If you want to preview 
the animation at the smooth production speed (or  nearly  so),  
use Window >Playblast. 

http://download.autodesk.com/
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Keyframes define "start" and "end" positions for an object and the 
computer fills in the rest. 

 
A quick way to key an object is to select it and press S. 
Pressing S will set all the attributes of a particular object. If you 
would like to set an individual key, right click the property in the 
channel box and select "Key Selected". 

 
When an object is selected, every frame that contains Key 
information for that object will have a red bar in it. 

 

http://download.autodesk.com/ 
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Forsomequickanddirtyeditingofkeyframes,youcanselectthem 
inthetimelinebyholdingshiftandclick-draggingthemouseacross your 
desired area. It will be highlighted inred. 

 

 
 
 
 
 

Exercise  

At this point, you can move and scale the keys with the arrows. 
There are also options such as "Delete Key" when you right click on 
theredarea.Bewareofscalingkeysthisway.Ifakeyisscaledand 
landsbetweenframes,youranimationwillnotbeveryprecisesince it 
rounds your keys to integer values. A much better way to edit keys 
is through the grapheditor. 

Animate the translate value of a sphere and add in between keys to make the sphere up in the middle. 
 

Assessment  
 

Fill in the blanks 
 

1. Mayacreatesmotionbetweenthepositions.Bydefault,animationplaysinaloopfromframe 1to . 
2. Keyframesdefine" " and "end" positions for an object and the computer fills in the 

rest. 

3. If you want to preview the animation at the smooth production speed (or nearly so), use Window> 
 . 

4. PressingSwillsetalltheattributesofaparticularobject.Ifyouwouldliketosetanindividualkey, right click 
the property in the channel box andselect "Key ". 

 

Checklist for AssessmentActivity  
 

Use the following checklist to see if you have met all the requirements for assessment activity. 
 

Part A 

Differentiated between the following: 

1. Translate androtate 
2. Scale andcolour 

 
Part B 

Discussed in class the following: 

1. Describe the wordtangents? 
2. How to set keyframes to make the ballbounce 

 
Part C 

Performance standards 

The performance standards may include, but not limited to: 
 

Performance Standards Yes No 
Set keyframes to make the ball bounce   



 

Session 3: GraphicEditor 

 
In this session, you will learn about Graphic Editor and editing animation curves using graphic editor. 

 
RelevantKnowledge  
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This is your graph editor. It displays all information about the 
selected object in graph format. 

You define the "end points" of the movement, but how does the 
computer fill in the blanks? Answer: curves. Because there are 
curves, you can edit their curving behaviour. 

Here you can move keys, scale them; edit the curve tangents, etc. 
You can break tangents to make sharp changes in direction (i.e. a 
ball hitting the ground). 

 
To move around in the graph editor, you use the same controls as 
in the perspective view, which are listed below just in case you 
have forgotten * Zoom: Scroll the middle-mouse button * Pan: 
Command+Middle-mouse button * F: Focus in on the currently 
selected keyframes 

 
To edit animation curves using the Graph Editor 

 
With the ball selected, select Window > Animation Editors > Graph 
Editor. 
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The Graph Editor displays several animation curves, one for each 
keyed attribute of the ball. The animatable attributes for the ball 
are listed in the left column. Specifically, it displays the attributes 
of the selected transform node of the ball. 

 
Each curve graphs how an attribute changes value during the 
animation. The column of numbers at the left represents attribute 
values that can be animated, while the row of numbers at the 
bottomrepresentstime(frame)values.Ateachpointonthecurve, 
youcanseethevalueofanattributeataparticulartime.Thesmall 
blacksquaresonthecurvesrepresentpointswhereyou’vesetkeys. 

 
Shift-Select only the Translate X and Translate Y attributes in the 
left column of the Graph Editor. 

 
Now  only  the  animation  curves  for Translate  X and Translate  
Y appear in the GraphEditor. 

 
This simplifies the display. With too many curves present, it’s hard 
to see specific curves. When you use the Graph Editor, you usually 
focus on one or a fewcurves. 

 
Tocentrethedisplayoftheanimationcurves,selectView>Frame 
Selection (in the Graph Editor window). If you want to see more 
detail in the graph, use your mouse to dolly and track the graph 
view. 

 
The green curve represents Translate Y, while  the  red  
represents Translate X. The colour of each curve matches its 
attribute name. This colour scheme is consistent throughout Maya 
for X, Y, and Z (red, green,blue). 
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If you have never used a graph editor before, the relationship 
between a curve’s shape and the animation it represents might be 
hard to understand. With experience, you will quickly recognize 
how curve shape affects animation. 

 
In the above graph, the straight curve of Translate X indicatesthat 
the ball moves horizontally across the ground at a constant rate 
overtime. 

 
The wavy curve of Translate Y indicates that the ball increases its 
height steadily until frame 33, dips more quickly until frame 50, 
then rises and dips again until frame 72. 

 
Whentheballfirstbouncesoffthegroundatframe50,itseemsto float 
and slip rather than rebound. The shape of the Translate      Y 
curve illustrates why. Near frame 60, the curve is soft and 
rounded. The Translate Y values gradually decrease to the low 
point then gradually increase. The transition from decreasing to 
increasing values issmooth. 

 
The Graph Editor’s usefulness lies in the fact that you can edit the 
shape of the animation curves to edit the animation of any keyed 
attribute.Tocreateasharpbounce,youcaneditthecurvesothat the 
transition from decreasing to increasing values is abrupt at frame 
50. Specifically, you’ll create a corner at that key point rather 
than a roundedcurve. 

 
Select the point on the Translate Y (green) curve at frame 50. This 
causes a pair of tangent handles to appear at the point. Each end 
point of the newly displayed straight line is a tangent handle. The 
handles let you control the curvature near the key point. 



 

Animation curves have a few control structures for curve editing. 
You can do any of these operations: 

 
a. Use the Move tool and middle mouse button to move a key 

point. You can alternatively use your keyboard to enter 
precise values for a selected key’s frame and value in the 
boxes above the grapharea. 

b. Use the Move tool and middle mouse button to drag the 
tangent handles and change the adjacentcurvature. 
(You can shift-drag with the Move tool to constrain a move 
operation to a single direction.) 

c. Use the Scale tool and middle mouse button to scale 
selected key points closer together or furtherapart. 

d. Use the Graph Editor’s Tangents menu items to change the 
adjacent curvature. This is the operation you’ll use in the 
nextstep. 

 
In the Graph Editor, select Tangents > Linear. 

 
1. These changes the curvature around the key point from 

rounded to cornered. Specifically, the setting you select 
specifies how the key point tangent handles lie at this key 
point. This affects the type of interpolation between key 
points. 
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2. Play the animation and you will see the ball bounce more 

sharply. To sharpen the bounce more, you need to editthe 
positioningofthetangenthandlestosteepenthecurvature 
approaching the key point. 

3. Select one of the tangenthandles. 
4. Use the Move Tool and the middle mouse button to drag it 

upwards a little so you can see the how the curvature at 
the key point changes. By default, when a pair of tangent 
handles shares a key point, they work as a unit. Move one 
and you move the other in an opposing direction. This is 
often desirable in an animation curve, because it ensures 
thecurvatureatthatpointstayssymmetrical.Symmetrical 
curvature often helps prevent unusual animationshifts. 
Inthiscase,however,youwanttosteepenthecurvature’s 
approach toward the curve point in the same direction on 



 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Exercise  

both sides. You therefore need to break the symmetrical 
interdependency between the two tangents. 

5. Undo your previous move of the tangenthandle. 
6. Select the key point at frame 50 (not a tangenthandle). 
7.  In the Graph Editor, select Keys > Break Tangents. 

This lets you move each tangent handleindependently. 
8. Select the right tangent handle and use the Move Tool to 

moveitupalittle.Dothesameforthelefttangenthandle? Be 
careful not to select the keypoint. 

 

 

 
 

Use graph editor to adjust the timing and weight of the previously done animation. 
 

Assessment  
 

Fill in the blanks 
 

1. The Graph Editordisplaysseveral curves, one for each keyed attribute of 

theball. 

2. The Graph Editor’s usefulness lies in the fact thatyoucan the shape of theanimation 

curves to edit the animation of any keyed attribute. 

3. To create a sharp bounce, you can edit the curve sothatthe from 

decreasing to increasing values is abrupt at frame50. 
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This sharpens the bounce to simulate the effect of gravity and 
elasticity. 



 

Checklist for AssessmentActivity  
 

Use the following checklist to see if you have met all the requirements for assessment activity. 
 

Part A 
 

Differentiated between the following: 
 

1. Tangent line and secantline 
2. Tangent and slope to atangent 

 
Part B 

 
Discussed in the class the following: 

 
1. What is grapheditor 
2. Describe the word tangents and linear. 

 
Part C 

 
Performance standards 

 
The performance standards may include, but not limited to: 

 
Performance Standards Yes No 
Demonstrated the knowledge of editing animation curves using the Graph Editor   



 

Session 4: Creating a BouncingBall 

 
Inthissession,youwilllearnabouttherepresentationofdifferentbouncingball.Youwillalsolearnto use the 
middle mousebutton. 

RelevantKnowledge  

We could easily go through each button and short cut, but it is 
probably best to explain how to do things using an example. 

 
You begin this lesson by placing in the basic key frames of the ball 
bouncing up and down. Then, you progress to having the ball move 
from one side of the screen to the other. Next, you layer in the 
rotations of the ball and end with the squash and stretch. 

 
The bouncing ball exercise is a good place to start, because there 
arenottoomanycontrollerstouseina3Dapplicationandbecause it 
deals primarily with basic movement. You should have a good idea 
of what a bouncing ball looks like. Before beginning this exercise 
in Maya, it is best to look at a 2D drawing of what a ball actually 
looks like when itbounces. 

 
Takeforexampleabouncingball.Arubberballbounceshigherand 
squashs more upon impact than a hard league ball. The ease with 
which an object squashs and stretches defines the rigidity of the 
material making up an object. We will be imitating a rubberball. 

 
First create a ball by creating a simply polygonal sphere. If you do 
notrememberhowtodothis,pleasereferbacktotheIntroduction to 
Mayatutorial. 
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You can change the view of the top panel to "side" view for the 
purposes of the exercise by going to Panel > Orthographic > Side. 
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To set the ball bounce, you can set three keys: high, low, and high. 
You position the ball where you want (either by moving with the 
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movetoolorbychangingvaluesinthechanneleditor)attheframe you 
would like (by selecting that frame on the timeline) and then 
hitting "S" to set key. For this exercise, it is best to place the keys 
overaspanofabout100framestohavetheballmovemoreslowly for 
viewingpurposes. 

 
Looking at the graph editor, we can see the curves made by the 
computerareincorrect!Ballsdonotslowasitapproachestheplace 
ithits. 
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This is better! Let's see how we get our graph to look like this. As 
we see, the up and down movement of the ball is determined by 
they-axisofthegraph.Wecanviewjustthisbyselecting"Translate Y" in 
the grapheditor. 

 
Wenowmustchangethetangentangleofthelowposition.Youdo this by 
left-clicking the bottom point and selecting the "Break Tangent" 
button. This will separate the tangent line in two so the 
twosidesareindependentlycontrolled.Selecttheendpointofone side 
of the tangents, hit the W key (for the move tool) and use  
themiddle-mouse-button to change the steepness of that angle. 
Dothisfortheoppositewhisker.Youcanleavethetwohighpoints as they 
are, or adjust the angle without breaking the tangent of those 
aswell. 

 
You can now try hitting the "Play" button on the timeline to see 
what your ball looks like. 

 
We can take this one step further by adding a deformer to the ball 
to create the "squash and stretch" attribute a rubber ball has. To 
do this, select "Animation" from the menu drop down, go toCreate 



 

Deformer > Nonlinear > Squash. Right now, the deformer is not 
attached to the ball so if you try to change its values it will not do 
exactlywhatwewouldlike.Inordertoattachthedeformertothe 
ball,wemust firstselectthedeformerintheoutliner,command- click 
the ball, then go to Edit > Parent in the menubar. 
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Now that we parented the deformer, we can see in the channel 
editor that the "squash" input is now available by clicking"Squash". 
Ifyouselect"Factor",youcanplaywiththedeformerinperspective 
viewbymovingthemousewhileholdingthemiddle-mouse-button. 

 
Inthefirsthighposition,weknowthattheballwillbe(forthemost part) a 
perfect sphere. At the initial frame position, we should right-click 
"Factor" and click "KeySelected". 

 
Now go a few frames before the ball hits the low point and have 
the ball be taller. 
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Once the ball hits the bottom, it will be squashed. 

 

 
Youcanrepeatthestepsforthefollowingside,justintheopposite order. 

 
You may notice that because of the squash, our ball no longer 
touchestheground!Weeasilyfixthisbygoingintoourgrapheditor, left 
clicking the point, hitting W, and then using middle mouse button 
to move the pointdown. 

 
Your ball bounce should now look something like this. We can now 
do even cooler things with the ball bounce. 

http://www.youtube.com/watch?v=9xaQjPYQZmM


 

Exercise  
 
 

1. Create a bouncing ballanimation. 
2. Create three spheres and animate them separately, showing differentweight. 

 

Assessment  
 

Fill in the blanks 
 

1. Tangent angle of the low position can bechangedby -clicking the bottom pointand 
selectingthe" Tangent"button. 

 
2. To create the "squash and stretch" attribute, adding a deformer to the ball is to be done. To do 

this, select "Animation" from the menu drop down, go to Create Deformer>  
> Squash. 

 
3. Nowthatweparentedthedeformer,wecanseeinthechanneleditorthatthe" " 

inputisnowavailablebyclicking"Squash".Ifyouselect" ", you can play with the 
deformer in perspective view by moving the mouse while holding themiddle-mouse-button. 

 
4. Inthefirst position, we know that the ball will be (for the most part) a perfect 

sphere. At the initial frame position, we shouldright-click" " and click "Key 
Selected". 

 

Checklist for AssessmentActivity  

Use the following checklist to see if you have met all the requirements for assessment activity: 
 

Part A 
 

Differentiated between squash and stretch. 
 

Part B 
 

Discussed in class the following: 
 

Describe the stapes of creating a bouncing ball. 
 

Part C 
 

Performance standards 
 

The performance standards may include, but not limited to: 
 

Performance Standards Yes No 
Demonstrated the knowledge of creating bouncing balls through animation   
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Introduction 

 
 
 

Camera and Motion Path 
Animation 

In this unit, we will discuss about the creating and animating 
camera, normal and motion path animation. 

Camera animation is very important thing for an animation movie, 
becausethereisnosenseofmakingananimatedmoviewithastatic 
camera, as cinematographysaid. 

There are exciting camera angles, cut and transition in a movie is 
ofthesameimportanceastheanimatedcharacterwhenanimation is 
nothing but an art of good storytelling. 

From this unit, you will learn how to use a camera according to a 
path, which will help you to communicate the audience better. 

Thereisalsoasessionaboutpathanimation,whichwillhelpyouto 
animate any object according to a specific path decided by the 
animator. You can always modify the path later, whenrequired. 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 



 

Session 1: CreatingCameras 

In this session, you will learn about the cameras and its functions. You will also learn about the path 
animation. 

RelevantKnowledge  
 
Create > Cameras > Camera 
 
There are three types of perspective cameras in Maya. As with 
Maya'slights,youcanchangeacameratoanyothercameratypein the 
AttributeEditor. 
 
Camera 
 
With this camera type, you see only the camera icon. In general, 
because  this  camera  freely  rotates  and  loses  track  of  its  
"up" vector, you should use it only when you're linking the camera 
to another object for movement and animation, or when you are 
placing a camera in one fixedspot. 
 
Camera and Aim 
 
This camera includes a camera target and an aim handle for 
adjustingthecameratarget.Inaddition,thiscameraautomatically 
stays level in relation to the horizon, so it is the one you will use 
most often. You can make this camera roll if you want, but by 
default, it stays level except at extreme straight-up or straight- 
downorientations. 
 
Camera, Aim and Up 
 
This camera type includes two handles: the aim handle, described 
for Camera and Aim, and an up handle for banking (levelling) the 
camera. This camera type is useful when you want to bank the 
camera during your animation. 
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http://www.expertrating.com/


 

Camera Settings 
 

These are the key settings for cameras under the 
Camera Attributessection: 
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Camera Attributes 

 
A camera’s attributes describe various properties of the camera, 
including angle of view, focal length, and depth of field. 

 
Controls In this drop-down list, you can quickly select the camera 
type you want. 

 
Angle of View and Focal Length: It controls the amount of 
perspective exaggeration. Raising the angle of view attribute lowers 
the focal length attribute. 

 
Camera Scale: You can change the camera size in relation to your 
scene, which affects scene objects when you render. Camera Scale 
is like a multiplier for the Angle of View setting. For example, 
decreasing Camera Scale to 0.5 halves the camera's view area, but 
makes objects in the scene look twice as large. 
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Clip Planes: Only objects located within the values specified for 
the camera's clip planes appear in the scene. If distant objectsare 
not showing up in your scene, raise the Far Clip Plane value. If 
nearby objects seem to be appearing in cross-section or not 
appearing at all, lower the Near Clip Planevalue. 

 
DepthofFieldEnable:Thedistanceblurswiththisattribute.Itcan be a 
render-intensive effect, but yields a nice cinematic result because 
objects close to and far away from the focus point are 
progressively blurred. You can view the calculated distance of the 
camera from the object and apply that value to the Focus 
Distance for the camera to achieve Depth ofField. 

 
BackgroundColour:Thebackgroundfillcolourforimagesrendered 
from this camera; you can also use this section of the Attribute 
Editor to add an image or shader as thebackground. 

 
Orthographic Views 

 
Orthographicviewsaretwo-dimensionalviewsofthree-dimensional 
objects. Orthographic Projection is a way of drawing an 3D object 
from different directions. Usually a front, side and plan view are 
drawn so that a person looking at the drawing can see all the 
important sides. Orthographic drawings are useful especially when 
a design has been developed to a stage whereby it is almost ready 
tomanufacture.Therearetwowaysofdrawinginorthographic 
-FirstAngleandThirdAngle.Theydifferonlyinthepositionofthe plan, 
front and  side  views.  Below  is  an  example  of First  
Angleprojection.Youcancreateperspectivecameras,rotatethem 
intoposition,andthensetthemtoorthographictogeta"flat"view for 
projecting textures onto anobject. 

 
Path animation allows you to animate an object along a path 
specified by a curve. In this way, the curve controls the motion 
of the object. With path animation, the motion for the objectis 
defined by its location along the pathcurve. 

 
Path animation is useful for animating objects such as trains, 
boats,airplanes,andmovingcameraswhosemotionfollowsaset 
path. To animate an object to do this type of motion smoothly 
withkeyframeanimationwouldrequireyoutolaboriouslycreate and 
edit many keys for the motion. By having the object move along 
a curve, you can easily adjust the object’s path byediting 
the curve. 

Exercise 

1. Open one of your previously created scenes. Create a) camera, b) camera and aim, c) camera, 
aim andup. 

2. Make a chart differentiating the properties of these three cameraoptions. 



 

 
 

Fill in the blanks 
 

1. Attributes of camera includeangleof ,focal , and depth offield. 

2. There are two ways of drawing inorthographic- Angle and ThirdAngle. 
 

 
Use the following checklist to see if you have met all the requirements for assessment activity. 

 
Part A 

 
Differentiated between the following: 

 
Angle of view and focal length. 

 
Part B 

 
Discussed in class the following: 

 
What are the camera’s attributes? 

 
Part C 

 
Performance standards 

 
The performance standards may include, but not limited to: 

 
Performance Standards Yes No 
Demonstrate the use of camera settings and attributes in Maya   

Assessment 

Checklist for Assessment Activity 



 

 
 

 
 
 
 
 
 

Session 2: Animating the Camera  

 
In this session, you will learn about the process of animating the camera, parametric length. You will 
also learn in detail about path animation. 

Relevant Knowledge When you first begin animating the camera, it helps to follow the 
rules of videography, such as avoiding jarring camera motions— 
rapid pans, zooms, or rotations of the camera. In addition, you 
should usually give the camera the impression of having mass. 

 
The virtual camera, by default, starts and stops moving instantly, 
which looks unrealistic and abrupt to viewers. To avoid this 
problem, adjust the tangents for the camera position's start and 
stop keys in the Graph Editor so that motion begins and ends 
gradually. Do the same for the camera's aim point keys and any 
other animated camera attributes 

 
Animate > Motion Paths > Attach to Motion Path 

 
Places and links the selected object to the current curve. The 
current curve becomes the motion path. 

 
Animate > Motion Paths > Attach to Motion Path > 

 
Opens the Attach to Motion Path Options. 

 
Start Time 

 
Specifies the start time of the motion path animation. Only 
available when Start or Start/End in Time Range is on. 

 
End Time 

 
Specifiestheendtimeofthemotionpathanimation.Onlyavailable when 
Start/End in Time Range ison. 

 
Parametric Length 

 
Specifies the method Maya uses to position an object as it moves 
along a curve. There are two methods: the parametric space 
method and the parametric length method. 

 
Intheparametricspacemethod,themarkersrepresentpositionsin the 
U-parameter space of the curve. In the parametric length method, 
the markers represent positions as a percentage of the total curve 
length. The parametric length method is also known as the 
“fraction mode” method because the evaluation of the path is 
based on a fraction of the length of the path curve. 

 



 

To understand the difference between the two methods, consider 
a curve that has uniform parameterization and unevenly spaced 
CVs. 
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The curve above was created with five CVs and uniform knot 
spacing. The beginning of the curve is at U=0.0 and the end of the 
curveisatU=2.0.Theconewasanimatedwithpathanimationfrom time 
1 to30. 

 
If the path animation for the cone is created with the parametric 
length method, the cone will move evenly along the curve from 
times 1 to 30. 

 
If the path animation for the cone is created with the parametric 
spacemethod,theconemovesquicklyfromthefirsttothesecond 
CV,thenslowlythroughthesecondtofourthCV,thenquicklyagain from 
the fourth to fifth CV. This is because the second and fourth CVs 
are positioned at approximately U=0.5 and U=1.5 
parameterizationpointsofthecurve.Thesepointstakeuphalfthe total 
parameterization of thecurve. 

 
In parameter space, the object moves smoothly from U=0.0 to 
U=2.0. In world space, there is little movement of the object from 
(roughly) times 8 to 23, which coincide with the large parameter 
distance that must be covered in the correspondingly small curve 
length. 

 
The advantage of using the parametric space method is that if you 
have spent time adjusting the timing of the object’s movement 
along the curve, CVs can be added to the beginning or end of the 
curve without affecting the timing of the motion on the existing 
part of the curve. 

 
The advantage of using the parametric length method is that it is 
easytoobtainsmoothtimingoftheobject’smotionwithouthaving 
toinserttimingmarkerstorefinethetimingoftheobjectalongthe 
pathcurve. 
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Turning off Parametric Length selects the parametric space 
method. Turning on Parametric Length selects the parametric 
length method 

 
Follow 

 
Ifon,Mayacomputestheobject’sorientationasitmovesalongthe 
curve. It is on bydefault. 

 
Maya uses a front vector and an up vector to compute the 
orientation of the object. Maya aligns the object’s local axes with 
the front vector and the up vector so that it knows how the object 
should be pointing upwards and frontwards as it moves along the 
curve. 

 
At any point along the curve, the front vector aligns with the 
tangent to the curve, pointing in the direction of movement. The 
up vector is perpendicular to the tangent, but you must still tell 
Maya which perpendicular direction from the tangent is the up 
direction that you want. To do so, you specify a world up vector 
withwhichtheupvectoraligns.UsetheWorldUpType,WorldUp 
Vector, and World Up Object options to specify the world up 
vector. 

 
You need to tell Maya which of the object’s local axes should be 
alignedwiththefrontvector,andwhichshouldbealignedwiththe up 
vector. To view the object’s local axes, select the object and 
select Display > Component Display > Local Rotation Axes. Next, 
specify which local axis aligns with the front vector with Front 
Axis.AlsospecifywhichlocalaxisalignswiththeupvectorwithUp Axis. 
Finally, you specify the type of world up vector (World Up Type) 
with which the up vector itselfaligns. 

 
The world up vector gives you the ability to control what the up 
vector considers to be the up direction. One benefit of this is that 
you can correct any sudden flipping problems as the object moves 
alongthecurve.Forexample,youcanhavetheworldupvectorbe the 
local axis of some other object such as a locator. You can then 
directly control the orientation of the world up vector by 
manipulating the locator. 

 
Tip: When attaching an aimed camera to a curve as a motionpath, 
turn off the Followoption. 

 
Front Axis 

 
Specifies which of the object’s local axes aligns with the front 
vector.Thisspecifiesthefrontwardsorientationoftheobjectasit 
travels along thecurve. 

 
X aligns the local X axis with the front vector, specifying the X axis 
as the forward-facing axis of the object. 



 

YalignsthelocalYaxiswiththefrontvector,specifyingtheYaxis as the 
forward-facing axis of theobject. 

 
Z aligns the local Z axis with the front vector, specifying the Z axis 
as the forward-facing axis of theobject. 

 
Up Axis 

 
Specifieswhichoftheobject’slocalaxesalignswiththeupvector. This 
specifies the upwards orientation of the object as it travels along 
the curve. The up vector aligns with the world up vector specified 
by the World UpType. 

 
XalignsthelocalXaxiswiththeupvector,specifyingtheXaxisas the 
upward facing axis of theobject. 

 
YalignsthelocalYaxiswiththefrontvector,specifyingtheYaxis as the 
upward facing axis of theobject. 

 
Z aligns the local Z axis with the front vector, specifying the Z axis 
as the upward facing axis of theobject. 

 
World Up Type 

 
Specifiesthetypeofworldupvectorthattheupvectoralignswith. 
Selections  includeScene   Up, Object   Up, Object   Rotation Up, 
Vector, andNormal. 

 
Scene Up 

 
Specifies that the up vector try to align with the scene’s up axis 
insteadoftheworldupvector.Theworldupvectorisignored.You can 
specify the scene’s up axis in the Preferences window. The 
default scene up axis is the world space positiveY-axis. 

 
Object Up 

 
Specifies that the up vector try to aim at the origin of a specified 
object instead of aligning with the world up vector. The world up 
vector is ignored. The object whose origin the up vector tries to 
aim at is called the world up object. You can specify the world up 
object with the World Up Object option. If no world up object is 
specified, the up vector tries to aim at the origin of the scene’s 
world space. 

 
Object Rotation Up 

 
Specifies that the world up vector is defined relative to some 
object’s local space instead of the scene’s world space. The up 
vector tries to align with the world up vector after transforming it 
relativetothescene’sworldspace.Theobjectwhoseorigintheup 



 

vectortriestoaimatiscalledtheworldupobject.Youcanspecify the 
world up object with the World Up Objectoption. 

 
Vector 

 
Specifies that the up vector tries to align with world up vector as 
closely as possible. The world up vector is defined relative to the 
scene’s world space. (This is the default.) Use World Up Vector to 
specify the direction of the world up vector relative to the scene’s 
world space. 

 

 
1. Create a path and a basic primitive. Attach the object to the motionpath 
2. Animate the object through the motionpath. 
3. Create a new path and a low poly train. Follow the train with thepath. 
4. Make a chart and write down your experience of animating object through a motion path. Note 

down the U values with respect to thetime. 
 
 

 
Answer the following questions 

 
1. What is parametriclength 

 

 

 

 

 

 

2. Describe the terms: Object Rotation Up, Object Up, SceneUp 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

Exercise 

Assessment 



 

 

Use the following checklist to see if you have met all the requirements for assessment activity: 
 

Part A 
 

Differentiated between the following: 
 

Object up and object rotation up 
 

Part B 
 

Discussed in class the following: 
 

1. Object RotationUp 
2. ObjectUp 
3. SceneUp 

 
Part C 

 
Performance standards 

 
The performance standard may include, but not limited to: 

 
Performance Standards Yes No 

Demonstrate the knowledge of application of concepts and processes in camera   

Checklist for Assessment Activity 



 

Session 3:Normal  
 

In this session, you will learn about the normal, world up vector, world up object and bank scale. 
 

Normal 
 

A normal is a theoretical line, perpendicular to the surface of a 
polygon.InMaya,normalsareusedtodeterminetheorientationof a 
polygon face (face normals), or how the edges of faces will 
visually appear in relation to each other when shaded (vertex 
normals). 

 
Face Normal 

 
The front of a polygon’s face is graphically represented using a 
vector called the polygon’s normal. The order of vertices around 
thefacedeterminethedirectionoftheface(whetherasideofthe 
polygonisthefrontortheback).Forexample,ifyouplacevertices in a 
clockwise direction, the face normal points downward. If you 
place vertices in a counter-clockwise direction, the face normal 
points upward. When you shade or render polygons, the normals 
determinehowlightreflectsfromthesurfaceandtheshadingthat 
results. 

 
Vertex Normals 

 
Vertex normals determine the visual smoothing between polygon 
faces. Unlike face normals, they are not intrinsic to the polygon, 
butratherreflecthowMayarendersthepolygonsinsmoothshaded 
mode. Vertex normals appear as lines projecting from the vertex, 
one for each face that shares thevertex. 

 
Normal in Maya are invisible unless you explicitly change your 
display settings to reveal them. The easiest way to see which way 
a model's normals are facing is to go to the Lighting menu at the 
top of the workspace and uncheck Two-Sided Lighting. 

 
With Two-Sided Lighting turned off, reversed normals will appear 
black. 

 
Specifies that the axis specified by Up Axis will try to match the 
normaltothepathcurve.Theinterpretationofthecurvenormalis 
different depending on whether the path curve is a curve in world 
space, or a curve on surfacecurve. 

 
If the path curve is a curve in world space, then the normal of the 
curve is the direction that points to the centre of curvature of the 
curve at any point on the curve. This is best illustrated by the 

Relevant Knowledge 



 

arrows in the diagram below, which indicate the normal to the 
curve at various points: 
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Notethatthenormaltoacurvewillflip180degreeswhenthecurve 
changesfromaconvextoconcave(orviceversa)shape.Thismakes the 
Normal option for the Up Direction not very desirable when using 
a world-space curve in your pathanimation. 

 
Ifthepathcurveisacurve-on-surface,thenthenormaltothecurve is  
the  normal  to  the  surface  at  that  point  on  the  curve.  The 
Normal option will give the most intuitive results when the path 
curve is acurve-on-surface. 
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World Up Vector 
 

It specifies the direction of the world up vector relative to the 
scene’s world space. Because Maya’s world space is “Y-up” by 
default, the default world up vector points in the direction of the 
world space’s positive Y-axis (0.0000, 1.0000, and 0.0000). 

 
World Up Object 

 
It specifies the object the world  up vector tries to  align with      
ifWorldUpTypeissetto ObjectUp orObjectRotationUp.For 
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example, you could specify the world up object as a locator that 
you can rotate as needed to prevent any sudden flipping problems 
as the object moves along the curve. 

 
Inverse Up 

 
If this option is on, Up Axis tries to align itself with the inverse of 
up vector. 

 
Inverse Front 

 
Reverses the frontwards direction an object is pointing along the 
curve. This is especially useful when you are trying to orient a 
camerasothatitpointsfrontwardsalongacurve.Forexample,you have 
got the camera pointing backwards along the curve, but are 
havingdifficultygettingthecameratopointfrontwards.Byclicking 
InverseFronton,youcanhavethecamerapointforwardsalongthe curve 
as desired. 

 
Bank 

 
Banking means the object will lean in towards the centre of the 
curvatureofthecurvethatittravelsalong(likeamotorcyclegoing 
around a corner). The bank option is only available if the Follow 
option is on, as banking also affects the rotations of theobject. 

 
The path animation automatically computes how much banking 
should occur depending on how curved the path curve is. You can 
adjust the banking using Bank Scale and Bank Limit. 

 
Bank Scale 

 

If you increase the Bank Scale, then the banking effects will be 
more pronounced. For example, if the Bank Scale is set to 2, then 
theobjectwillbanktwiceasmuchasthedefaultthatiscomputed. 

 
Bank Limit 

 
The Bank Limit lets you restrict the amount of leaning. For 
example, the Bank Scale may be increased to obtain pronounced 
effects,butthenthismaycausetheobjecttoleantoomuchwhere the 
curve is much curved. This option will limit the leaning to the 
givenamount. 

 
 

Note 
 

Youcanenteranegativenumberfor BankScale.Thiswillcausethe 
object to lean out, away from the centre of the curvature of the 
curve,ratherthanintowardsthecurvature.Forexample,youcould 
usethisinanimatingcharactersthrownfromsidetosideinaroller 
coaster. 



 

 
 

  

1. Animate the bank value of the previousexercise. 
2. Note down the U and Bank values with respect to thetime. 

 

 
Answer the following questions 

 
1. A normal is atheoreticalline, to the surface of apolygon. 

2. InMaya,normalsareusedtodeterminethe of a polygon face (face normals), orhowthe

offaceswillvisuallyappearinrelationtoeachother when shaded (vertexnormals). 
 

 
Use the following checklist to see if you have met all the requirements for assessment activity. 

 
Part A 

 
Differentiated between face normal and vertex normal. 

 
Part B 

 
Discussed in class the following: 

 
What is normal? 
What is the difference between face normal and vertex normal. 

 
Part C 

 
Performance standards 

 
The performance standard may include, but not limited to: 

 
Performance Standards Yes No 

Demonstrated the knowledge of face and vertex normals   

Exercise 

Assessment 

Checklist for Assessment Activity 



 

Session 4: Creating a PathAnimation  

In this session, you will learn how to create a path animation. 

RelevantKnowledge 
 
 
 
 
 
 
 
 
 

 
help.autodesk.com/ 

A path animation controls the position and rotation of an object 
along a curve. A NURBS curve cannot be designated as a motion 
path.Anobjectmustfirstbeattachedtothecurveforittobecome a path 
curve. You can also generate motion paths by animating objects 
using motion pathkeys. 

 
ThefollowingprocedureusesAnimate>MotionPaths>SetMotion Path 
Key to create a motion path animation. Alternately, you can 
alsouseAnimate>MotionPaths>AttachtoMotionPathtocreate 
motion pathanimation. 

 
To create a path animation 

 
1. Select the object you want to animate with the motion path 

and move it to its startingposition. 
2. Set the current time to the start time of your pathanimation. 
3. Select Animate > Motion Paths > Set Motion PathKey. 

 
Asingle-CVcurveiscreatedwithapositionmarkerattimespecified 
starttime. 

 

 
help.autodesk.com/ 

Increase current time and move the object to a new position. 

Select Animate > Motion Paths > Set Motion Path Key again. 

 
A single-span curve is drawn from the marker at the start time to 
the current position of the object, where a new marker is placed. 

 

http://download.autodesk.com/global/docs/maya2014/en_us/files/Animate__Motion_Paths__Set_Motion_Path_Key.htm


 

 
help.autodesk.com/ 

 
Continue changing the time and position by selecting Animate 
>Motion Paths > Set Motion Path Key for as long as you wish to 
animate the object’s position. 

 
The time at which the last motion path key is set is end time of 
your motion path animation. 

 
Note  that  once  you  have  created  a  path  animation  using   
the Animate > Motion Paths > Set Motion Path Key, you can use 
all of the other path animation tools as described in the previous 
sections to refine the basic pathanimation. 

 
Similarly,youcanselecttheobjectthatwasanimatedalongapre- 
existing path curve, and extend the length of its animation (and 
thusthepathcurve)byusing 
Animate>MotionPaths>SetMotionPathKey. 

 
Tip 

 
Ifyoudecideyoudon’tlikethepositionoftheobjectataparticular 
marker time, then change the current time to that marker’s time, 
and move the object to its new position. Select 
Animate>MotionPaths>SetMotionPathKey,andtheshapeofthecurv
ewillchange so that the marker is now at the object’s 
newposition. 

 
Youcanchangetheshapeofanexistingpathcurvebychangingthe 
current time, moving the object to a  new  position,  and  
selecting Animate > Motion Paths > Set Motion Path Key. An 
example of animation before and after this menu itemfollows: 

http://download.autodesk.com/global/docs/maya2014/en_us/files/Animate__Motion_Paths__Set_Motion_Path_Key.htm
http://download.autodesk.com/global/docs/maya2014/en_us/files/Animate__Motion_Paths__Set_Motion_Path_Key.htm
http://download.autodesk.com/global/docs/maya2014/en_us/files/Animate__Motion_Paths__Set_Motion_Path_Key.htm
http://download.autodesk.com/global/docs/maya2014/en_us/files/Animate__Motion_Paths__Set_Motion_Path_Key.htm
http://download.autodesk.com/global/docs/maya2014/en_us/files/Animate__Motion_Paths__Set_Motion_Path_Key.htm
http://download.autodesk.com/global/docs/maya2014/en_us/files/Animate__Motion_Paths__Set_Motion_Path_Key.htm
http://download.autodesk.com/global/docs/maya2014/en_us/files/Animate__Motion_Paths__Set_Motion_Path_Key.htm
http://download.autodesk.com/global/docs/maya2014/en_us/files/Animate__Motion_Paths__Set_Motion_Path_Key.htm


 

 
 

1. Create a low poly car, and attach it to a motionpath. 
2. Adjust the speed and bank value according to thepath. 
3. Note down the U and Bank values. 

 
 

 

A path animationcontrolsthe and rotation of an object along acurve. 
 
 
 
 
 

 

Usethefollowingchecklisttoseeifyouhavemetalltherequirementsforassessmentactivity. 
 

Part A 
 

Differentiated between the following: 
 

Creating a motion path by attaching an object to a curve and creating a motion path by using 
motion path keys. 

 
Part B 

 
Discussed in class the following: 

 
1. How to position the object on a pathcurve? 
2. How to animate an object along asurface? 

 
Part C 

 
Performance standards 

 
The performance standard may include, but not limited to: 

 
Performance Standards Yes No 

Demonstrate the knowledge of employing techniques to create a motion path by 
attaching an object to a curve 

  

Assessment 

Checklist for Assessment Activity 

Exercise 



 

Glossary  
 
 

2D Animation The rapid display of a series of drawings in a two-dimensional environment, 
such as through traditional cel animation or via animation software. The 
illusionofmotionisachievedbyslightprogressivechangesineachdrawingor 
"frame." 

3D Animation The animation of objects in a three-dimensional, digital environment. 

Active listening It is a process of analyzing and evaluating what another person is saying in an 
effort to understand the true meaning of the message. 

Animation The process of creating a progressively altering image that gives the 
appearance of continuous motion. 

Anticipation Anything a character does to prepare for an action; a device to prepare the 
viewer for the action. For example: pulling your character's arm back before 
he punches someone in the face. 

Aspect Ratio The ratio of the width to height for any frame or film format, used when 
discussing screen size standards such as a 4:3 aspect ratio for web or 
television, or 16:9 for widescreen. (A 4:3 ratio would be a 640 x 480 pixel- 
sized Flash document.) 

Autodesk Maya It is commonly shortened to Maya, it is 3D computer graphics software that 
runs on Windows, Mac OS and Linux. 

Cel ("Celluloid") A cel is a transparent sheet of plastic upon which traditional animation 
artwork was transferred, laid over a background and filmed. Early cel 
animation was done on nitrate cels, which were highly flammable. Safer and 
more durable acetate cels became the industry standard. 

Driven keys Driven Keys are used to drive the attributes of one object to another object. 

Effects animation The animation of non-character elements such as explosions, smoke and rain. 

Ergonomics An applied science that studies the interaction between people and the work 
environment. It focuses on matching the job to the worker. 

Extremes Poses at the extreme end of any motion. 
 

 



 

Frame A single image out of the sequence comprising an animation. 

Frame Rate The measurement of the number of consecutive images (frames) in an 
animatedmovie.Framerateismostcommonlyexpressedinframespersecond 
(FPS). 

Health The World Health Organization has defined health as more than just the 
absence of disease. Rather, it is a state of complete physical, mental and 
social wellbeing. 

In-Between(or 
"Tween") 

Successive frames of animation added between key poses to create fluid 
transitions. Flash software features "shape tweening" and "motion tweening" 
processes, whereby the user defines two key frames, and in-between frames 
are automatically generated 

Joints Points of articulation between the bones in a character rig. 

Key Frame A single still image representing a key pose in an animated sequence. 

Layout The art or process of arranging printed or graphic matter on a page. 

Lip Sync The process of synchronizing a character’s mouth to sounds in the dialogue 
soundtrack to give the illusion that the character is speaking or generating 
sounds. 

Melting Point The temperature at which a solid changes to a liquid. For mixtures, a range 
of temperatures may be given. 

Model sheets Model sheets are also used for references in 3D modelling. It usually is used 
as reference material so as to allow proper proportions in 3D modelling. 

Ones, Twos and 
Threes 

Techniques for drawing fewer frames: drawing a new picture for every frame 
("animatingontheones")ismuchmoretime-consumingthananimatingonthe 
twosorthrees.Most2Dcartoonsaresuccessfullyanimatedonthetwos,with 
only occasional ones. 

 
Persistence of Vision    Phenomenon where the eye's retina retains an image for a split-second after the image 

was actually seen, creating the illusion of motion when viewing images in closely-timed 
sequence to one another. 

 
Pivot To cause to rotate, revolve, or turn. 
 
Pixel Short for Picture Element, a pixel is the smallest element of an image displayed on a 

monitor or TV screen. It is a single point in a raster image. 
 
Rendering The last step when animating by computer, rendering creates computer- generated 

images from a series of mathematical calculations defined by a user's specifications. To 
"render" a digital scene, the software program would composite the various settings as 
viewed by virtual "cameras" into a final image or video. 

 
Rhythm It is the sequence that is repeated in a period of time. 
 
Rigging The process of preparing a character model for animation, including setting up an 

underlying skeleton, complete with constraints, controllers and kinematic systems, and 
linking it to the mesh of the character model. 

 
Stop-Motion Animation Animation produced by arranging real objects, taking a picture of them, repositioning 

the objects minutely, then taking another picture of them to create a sequence of 
consecutive images that create the illusion of motion. One of the most common forms of 
stop-motion animation is Claymation. "Go- Motion" is stop-motion animation in which 
motion blur is added to each frame to reduce the staccato effect of traditional stop-
motion animation. 



 

 
Story Boarding A panel or series of panels of rough sketches outlining the scene sequence and major 

changes of action or plot in a production to be shot on film or video. 
 
Timeline The frame-by-frame layout of all animation occurring in linear order from beginning to 

end. Timelines may be numbered by frame, by second (or other interval of time), or 
both. 

 
Vector Animation Animation whose art or motion is controlled by vectors rather than pixels. Vector 

animation is often cleaner and smoother because images are displayed and/or resized 
using mathematical values instead of stored pixel values. One of the most commonly 
used vector animation programs is Flash. 

 
Vector Image A vector-based image is made up of points and bezier curves. Vector images have no 

fixed size or resolution and thus scale easily. 
 
Walk Cycle The animation of a character's side-angle walk, which can be looped for longer walking 

scenes. 
 
 

SuggestedReading  
 

Books 
 

1. Autodesk Maya UserGuide. 
2. Animating with Flash 8 by AlexMichael 
3. Macromedia Flash 8 Bible by RobertReinhardt 
4. Adobe Photoshop CS6 Bible by Brad Dayley 
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